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PREFACE TO THE SECOND EDITION

The first edition of this book, which was based on Photoshop CS5,  was released 

on April 1, 2012. 

	 On May 7, 2012, Adobe released Photoshop CS6.

Although Photoshop CS6 is a significant upgrade in a number of respects, 

there are relatively few that significantly impact the content of the first edition 

of this book. (These include the Adobe RAW Converter’s sliders, Cropping, and 

Straightening.) My original intent in addressing the upgrades in Photoshop CS6 

was to outline the changes relative to my book, post the changes on my website, and 

let people download the update.

	 However, I recently reread a guide on where to photograph birds at a particular 

venue that had been updated multiple times. Each new upgrade was simply added 

to the end of the of the orginal text or most recent update. (This is analogous to my original 

intent with the second edition of this book.) The result when reading the “where 

to photograph” guide was that I repeatedly had to go back and forth among the original 

text and the multiple additions. 

	 To say the least, this was frustrating and caused me to change my intent with 

the second edition of this book. As a result, I have completely rewritten those 

sections that were affected by the release of Photoshop CS6 so that the reader would 

not have to constantly flip back and forth between the original and new sections.

Mike Hannisian
September 25, 2012

v

Short-eared Owl, Duck Haven, MT. Canon 1D Mark IV camera,
Canon 600mm f/4.0 lens, 2.0x III tele;

ISO 3200, f/8.0, 1/250
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Forward

Forty years ago, the binocular was the portal through which most 

people started enjoying birds and other wildlife. This scenario 

is changing quickly. Now, for an increasing number of people, it is the 

viewfinder of the camera that is the portal to a world of wonder 

and discovery. But while image capture has been made easy, image 

management remains, for most of us, a landscape filled with alien 

terms and esoteric procedures.

     This is just a long winded way of saying: “OK.  I’ve got the 

picture. Now what?”

     Enter Mike Hannisian. A highly skilled birder and celebrated 

nature photographer who has taken upon himself the challenge of 

turning “now what?” into “nothing to it.”

     I’m exaggerating...but not by much. Mike knows his subject and 

he knows how to articulate it.

     But the truth remains that photography’s greatest challenge now 

lies after the shutter is snapped. Technology has made getting 

pictures easy. It has made manipulating images difficult. Bridging 

the gap, getting you from “snap” to “ahh” without a lot of expletives 

in between is An Introductory eGuide to Post Capture Digital Workflow.

	     You can blunder your way through Adobe Photoshop on your 

own. Or you can use the cumulative wisdom of Mike, as codified in 

this guide, and save yourself a lot of frustration.
Mike Hannisian, Grand Canyon NP, AZ. Canon PowerShot G9 camera, Canon 

7.4-44.4mm f/3.5 lens @ 22mm, ISO 200, f/7.1, 1/500, by Nancy J Watson



     I don’t pretend to be an accomplished photographer myself. It is 

my wife Linda who is the photographer in the family. As co-partner 

in our several book projects, my job is simple wordsmithing.

	 But I have known Mike Hannisian for as long as I have known any 

birder (and this friendship goes back over thirty-five years now). We 

met many years ago at the annual dinner of the Urner Ornithological 

Club. Mike, a club member, was receiving the organization’s prize for 

most birds seen in a year by a club member. I was a guest of a member.

    By good fortune Mike and I sat next to each other and conversed 

for most of the evening. In truth and honesty the conversation just 

never stopped. He was, even in the mid-70s, in a Kodachrome Age, 

a skilled photographer. Generous with his images, many of the field 

identification slide shows I put together and used during the early 

years of New Jersey Audubon’s Cape May Bird Observatory had 

Mike’s brand on them.

	 In particular, I recall an image Mike passed my way of 

a juvenile Herring Gull. What was so notable about this image? 

The subject. Anyone can make birds as stunning as drake Wood 

Ducks or Black-throated Blue Warblers look good. But juvenile 

Herring Gull, a bird that is a study in basic brown, is hardly a bird 

that turns heads or wins second looks.

	 Unless the bird is transmuted by a skilled photographer! The 

background, the posture, and particularly the lighting and exposure 

turned this very average subject into an extraordinary image.

White-tipped Dove, Santa Cruz Ranch, Starr County, TX. 
Canon 1D Mark III camera, Canon 600mm f/4.0 lens, 

Canon 2.0x II teleconverter, ISO 500, f/8.0, 1/250, EC - 1/3.
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	 This is the kind of skill that Mike applies to his craft and this 

book. Reading An Introductory eGuide to Post Capture Digital Workflow 

may not insure that you will be as good a photographer as Mike 

Hannisian. But you will most assuredly be a much more confident 

and accomplished manager of images than you are now.  

     Congratulations to him. Knowledge and empowerment to you. 

The natural world is waiting for you and your photographic skills to 

be brought to bear. The rest of us will be the beneficiaries.

Pete Dunne
Chief Communications Officer
NJ Audubon
March 2012

Left: Fushia, Alaska Botanical Gardens, Anchorage, AK. Canon 7D 
camera, Canon 70-200mm f/2.8 lens, ISO 6400, f/11, 1/250.
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Right: Desert Cottontail, Santa Cruz Ranch, Starr County, TX. Canon 40D 
camera, Canon 600mm lens, ISO 400, f/6.3, 1/800, EC -1/3.
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SO WHO IS
MIKE HANNISIAN?

Mike Hannisian has been a Professor of English, a civil trial 
attorney, the Executive Director of a non-profit Land Trust, 

and a high school math teacher. (He readily admits he does not 

know what he wants to do when he grows up.) 

	 Mike has been a photographer since 1968 and a birder since 

1970. He has taught birding and led national and international birding 

tours, is an Associate Naturalist with the New Jersey Audubon 

Society’s Cape May Bird Observatory (CMBO), has written and 

photographed for local, state, and national publications, was a charter 

member of the Rio Grande Valley Chapter Texas Master Naturalists, a 

Certified Interpretive Guide, Resident Naturalist at Indian Ridge 

B&B, Mission, TX, and has repeatedly had winning images in the 

Valley Land Fund’s Wildlife Photo Contests, including Best of 

Contest in the 2008 South Texas Shootout. Mike recently returned 

to Cape May County, New Jersey, after nine years in the lower 

Rio Grande Valley of deep south Texas. 

	 Mike currently leads instructional photo walks and teaches 

photography for CMBO, the County library, and on an individual basis. 

He also has Facebook pages and many of his images, articles, reviews, and 

other writings can be found at www.mike-hannisian.com.

http://www.mike-hannisian.com
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Northern Harrier, Cape May Point SP, NJ. Canon 1D Mark IV camera, Canon 
500mm f/4.0 lens, Canon 1.4x II teleconverter, ISO 800, f/5.6, 1/2500, EC +1.
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Introduction

The advent of digital photography has, in many ways, made 

everyone a photographer as it has become easy and inexpensive 

to take pictures. You do not even need a camera, as such, since most 

of today’s computers, cell phones, and other electronic devices 

are capable of capturing digital images. 

	 I have been teaching digital photography for a decade, and the 

biggest issue that invariably arises, especially with those new to 

photography in general or new to digital photography in particular, is 

how to process RAW images. For new photographers, this is often 

the straw that breaks their back and causes them to either become 

resigned to being JPEG, snapshot-only shooters or, in the worst cases, 

to give up entirely on photography. For many experienced photographers 

new to digital capture, the issue is more often the steepness of the 

processing learning curve which can significantly impact the efficiency 

of their workflow, especially if their background is reversal film 

(slides) as they rarely developed their own images.

	 This second edition is designed to provide a step-by-step, basic 

workflow, using Adobe Photoshop CS6, that will provide those new 

to digital photography, or those who are experienced photographers 

new to digital, with an efficient method of downloading (Part 1), 

processing (Part 2), and organizing and storing (Part 3) their digital 

images. Part 2 includes “How-To” as well as “Why-Do-It-This-Way” 

sections. 	

	 The reason for this approach is so that those who are new to 

processing RAW images can do so without having to deal with 

the steep learning curve typically associated with digital 

processing. Once comfortable with the how of the process, 

you can, at your convenience, explore the why. This approach is 

also intended to quickly provide experienced photographers with a 

workflow that may well be more efficient than the one they are 

currently using. Likewise, the scope of Part 2 is purposely limited 

to a basic, easy to implement protocol. This is because there is so 

much that can be done in processing digital images, that to explain 

all of it here would likely discourage those new to digital capture to 

the point that they may be reluctant to learn the basics. Regardless, there 

is enough in this guide to allow all to efficiently download, process, 

organize, and store your digital images.	



Red-spotted Purple on Golden Chrysanthemum, 
Goshen, Cape May County, NJ. 

Canon 7D camera, Canon 300mm f/2.8 lens, 
ISO 500, 1/250, f/8.0, EC +1 2/3. 

The EC was unintended as noted in the text on pages 7 & 8. 

This is the processed, cropped version of the left image. 
Even though the original was over exposed by 1 2/3 stops, 

not all of the highlights were blown out.Thus, I was able to 
create an image that became one of my favorites and is now
in Kevin T Karlson’s new book, Visions, published in July 2012.
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	 Arguably, the most significant aspect of digital photography is 

that it has returned to you, the photographer, the option of 

complete control over your images. 	

	 However, many choose to forego this option. Underlying this 

issue is the fact that digital photographers have two initial choices: 

1) shoot in JPEG and let the camera process your images; or 2) 

shoot in RAW and process the images yourself. 

	 The former is convenient but has a significant drawback. If you 

shoot JPEGs, you are turning over the processing of your images 

to an algorithm (a mathematical formula) which does not know 

your photographic purposes or, for that matter, the circumstances 

under which you created your images. 

	 To make matters worse, after your images are processed by this 

formula, 7/8 of the data recorded by your cameras are permanently 

deleted! Should your exposure, composition, focus, etc., not be 

precise, this lack of data may preclude you from making a quality 

post capture adjustment. Also, this loss of data can make cropping as 

well as printing problematic. 

	 On the other hand, if you shoot in RAW you always have the 

full, original image to fall back upon. Furthermore, as digital processing 

software improves, and you become more skilled, you can return to 

your RAW files and reprocess them.

	 An example of an advantage of shooting in RAW is shown by 

the images on pages 5 & 6. 



Green Jay, Santa Clara Ranch, Starr County, TX. 
Canon 7D camera, Canon 600mm f/4.0 lens, 

ISO 1600, 1/500, f/5.6.

Northern Shoveler, Cape May Point SP, Cape May County, NJ. Canon 1D Mark IV camera, Canon 
600mm f/4.0 lens, Canon 2.0x III teleconverter, ISO 800, f/8.0, 1/2000.
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	 In September 2010, I purchased a Canon 300mm f/2.8 lens. I attached a camera 

body to it and went outside to test the lens. It was a sunny afternoon and a Red-spotted 

Purple was nectaring on Golden Chrysanthemums. I took a quick series of images of it 

and immediately went inside to see what they looked like. It was then that I realized that 

the last time I had used that camera, I had left it set to an exposure compensation of +1 

2/3. Had I been shooting in JPEG, there would have been nothing I could have done to 

save these images. Fortunately, I had shot them in RAW. Thus, I was able to correct the 

exposure, crop the image, and, as noted, one of this sequence is now in Kevin T Karlson’s 

July 2012 coffee table book, Visions. (Again, see the images on pages 5 & 6.)
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Ghost Crab, Cape May Point SP, Cape May County NJ. Canon 1D Mark 
IV camera, Canon 600mm f/4.0 lens, Canon 2.0x II teleconverter, 

ISO 1600, f/16, 1/800.

Red-Necked Grebe, West Chester Lagoon, Anchorage, AK. Canon 
1D Mark IV camera, Canon 500mm f/4.0 lens, ISO 500, 

f/14, 1/640, EC -2/3.
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	 As implied by the above, RAW images all but compel you to process 

(develop) them because unprocessed RAW captures are invariably 

flat and lifeless. Historically, to process RAW files you had to learn 

Levels, Curves, etc., and this takes time. True, to become a fully 

competent digital photographer, you need to understand these tools. 

The problem is that the learning curve can be quite time consuming 

and is invariably frustrating. As a result, many people never try to 

process RAW images, or give up before becoming successful.

	 Regardless of whether you shoot in JPEG or RAW, you need to 

figure out how to organize and store your images so that you can easily 

access them. With film, many people ended up with shoe boxes full of 

marginally (if at all) organized pictures. When I was shooting reversal

(slide) film, I had about 15 feet of standing three ring binders full 

of slides. Today, I have five external hard drives that serve as redundant 

storage for all my RAW and processed images. Furthermore, I now 

have about three times as many images as when I was shooting film, 

yet I can quickly pull up any of them because of my organizational 

system. In other words, it is critically important to be organized from 

the start of your photographic career because a major consequence 

of not being organized up front will be a significant amount of frustration 

and wasted time getting organized later!

	 Because I am primarily a nature/wildlife photographer, my examples 

will come from that realm. Regardless, the principles discussed in 

this book apply to all realms of digital photography, particularly for 

those of you who do not already have an efficient workflow.
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PART 1: FIRST STEPS FIRST

DOWNLOADING YOUR IMAGES

You have just returned from the field (or studio) with a camera 

full of images. Fine, but whether you shot in JPEG or RAW, 

what should you do next and how do you do it efficiently?

	 When I teach Introduction to Photography classes, which are 

intended for people with little or no photographic experience, 

the first session invariably has people who bring in point-and-shoot 

digital cameras with a nearly full card (the medium on which your 

camera records your images). 

	 When I ask them what they do with these pictures, a number 

say they show them to friends. When I ask how, they often demonstrate 

by showing me their images on their cameras’ LCDs. I then ask 

what they do after that, and they often shrug their shoulders. My 

next question typically is what do they do when their card is full, to 

which I get responses ranging from delete their images to put a new 

card in the camera to surprise that such a thing could happen.

	 It is not my intent to demean these students, or others similarly 

situated, a number of whom have become very good photographers. 

Rather, I note this simply to make the point that if you believe the 

camera ads about how easy it is to create great photos, you have been 

deceived (which, frankly, seems to be a major purpose of these ads). To 

fully realize the advantages of digital photography, you need to transfer

your images to your processing computer in a manner that allows 

you to easily and efficiently edit, name, process, organize, file, store, 

and access them. 

	 All this is to demonstrate that if you are not organized from the 

start, you run the risk of having a computer filled with images that 

you will have to go through, one at a time, to find the one(s) you 

are seeking. In other words, you will be in the same situation as a 

film photographer with a closet full of shoeboxes filled with 

marginally, if at all, organized images.

	 Before you move your images from your camera’s card to your 

computer, you should create a set of folders to hold them during the 

processing and storing phase. The structure I use is a folder labeled 

“New Images” with four subfolders: “Edited”, “File”, “New”, and 

“Process” (see the screen capture below). I also create a “Copies” 

folder  which I put on a different hard drive than my “New Images” 

folder. The reason for the “Copies” folder is that if my main hard 

drive fails before I have processed and stored these images, I have 

another copy of them.
	 You can download images 

directly from your camera or via 

a card reader. The conventional 

wisdom once was that you should 

not do the former because it 

depleted your camera’s batteries 



Below: Cooper’s Hawk, Goshen, Cape May County, NJ. 
Canon 1D Mark IV camera, Canon 300mm f/2.8 lens, 

Canon 1.4x II teleconverter, 
ISO 1600, f/4.0, 1/250, EC +1.
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Left: Five-striped Leaftail, Santa Cruz Ranch, Starr 
County, TX. Canon 40D camera, Canon 100-400mm 
f/4.5-5.6 @ 400mm, ISO 400, f/11, 1/125, EC -1/3.

and, obviously, you could not create more photos while your camera was being used to 

download images. However, today’s digital cameras have far better batteries, so the former 

argument is no longer much of an issue. Also, most people download images at home, 

not in the field, so the fact that you can not download and shoot at the same time 

is not relevant to most people. True, some people download in the field when their 

cards fill up, but the size of today’s cards (I use 32GB CF and 16GB SDHC cards) has 

made this much less of an issue. As a result, it usually matters little which download 

method you use.

	 I download images via a card reader. This is a small, relatively inexpensive ($15-

$50) device that plugs into a USB port. Most card readers accommodate a variety of 

cards which I like because, as noted, I use both CF and SDHC cards. My laptop 

has USB 3 ports, so I use a USB 3 card reader which downloads images 4-5 times 

faster (not 10 times as some claim) than a similar USB 2 reader.  Your computer will 

recognize any card reader as a drive. Likewise, if you connect your camera to a computer, 

the latter will recognize the former as a drive.
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Carolina Chickadee, 
Goshen, Cape May County, NJ. 

Canon 1D Mark IV camera, 
Canon 600mm f/4.0 lens, 

ISO 800, f/8.0, 1/320.

16	

Great Blue Heron, Cape May 
Point SP, NJ. Canon 7D camera, 

Canon 600mm f/4.0 lens, 
Canon 1.4x II teleconverter, 

ISO 500, f/10, 1/80.

	 I double click on the card reader drive, double click on the folder 

containing the images, and select all of the images (Ctrl A for PC; 

Cmd A for MAC - hereinafter Ctrl/Cmd A). I then copy them (Ctrl/

Cmd C). I next download (i.e.: paste) the images into my “New” 

subfolder (Ctrl/Cmd V). I then copy the same images into my “Copies” 

folder. If you have more than one card with images, repeat the above 

for each card. If you have cards from multiple days, as can happen if 

you have been on the road without a computer, you can add date 

labeled subfolders to your “New” subfolder. As noted, should you 

fail to use a “Copies” folder, you run the risk of loosing your images 

via a hard drive crash, copying failure, or other computer glitch. 

Again, most people ignore this until they loose their images!
	 Remember: You either have 

had a hard drive crash, or you 

are going to have one crash!
	 I must emphasize three ideas 

at this point. First, note that I have 

“copied” the images, not “cut” 

them. This is because if there is an 

error during the “cut” process, you 

could loose your images! 

	 Second, once you have copied 

your images to both subfolders, 

reformat your card(s). 

	 Do not erase your images 

while the card is still in your card 

reader as this may corrupt your 

card. Rather, reformat the card 

in your camera. 

	 Third, reformat the card at 

this time so you do not have a 

partially/fully filled card the next 

time you go shooting. 

	 Recently, I shot with a couple 

who had switched cameras. One of 

them started by formatting the 

card. Unfortunately, these people 

later realized that the other 

person had not downloaded 

the prior day’s images from that 

camera’s card which were now 

lost forever!

	 There are software programs that automatically download 

images. However, given that I occasionally add, subtract, and 

otherwise modify my folders and subfolders, I do not choose to 

use such programs as they invariably require altering your folders in 

that program. This usually involves a number of extra steps and, 

as such, I find it an unnecessarily cumbersome process.
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Right: Long-billed Thrasher, Dos Venadas Ranch, Starr County, TX. Canon 1D Mark 
II camera, Canon 600mm f/4.0 lens, ISO 400, f/6.3, 1/60, EC -1/3.

METADATA, EDITING, RENAMING

Metadata are information about your images. Some are recorded by your 

camera and cannot be changed. Others are added by you and can be edited 

as you wish, although it is more efficient to not edit absent a good reason. In 

order to read, add, or modify metadata, you need software. Generally, the software that 

comes with cameras is user unfriendly. Fortunately, Adobe’s Photoshop/Bridge 

and Lightroom can read the metadata of virtually all digital cameras. 

	 Just so it is clear, the more I use Lightroom the less I like it. There are three 

reasons for this. First, Lightroom imposes upon its users an organizational structure 

I do not like. Second, Lightroom requires that you make all your organizational 

changes using it. Third, and most significant, I process my images, to a very 

large extent, in Lab color space which Lightroom does not support. However, I 

know a number of very skilled photographers who use Lightroom and are quite 

happy with it. Regardless, these individuals invariably also use Photoshop when 

they want to do anything beyond that which can be done in Adobe Camera Raw 

(ACR - a subroutine that is part of Photoshop and Bridge), the limit of Lightroom’s 

processing capability.

	 Photoshop/Bridge, which Adobe simply calls Photoshop, is a pair of 

programs that cannot be purchased separately. If you buy Photoshop, you 

get Bridge. Likewise, the only way to get Bridge, is to buy Photoshop (or another 

Adobe product in which Bridge is embedded). Photoshop is the processing part 

of the package while Bridge is the editing/organizing part.



Left: Laughing Gull, Kimble Beach, Cape May County, NJ. Canon 1D 
Mark IV camera, Canon 600mm f/4.0 lens, Canon 1.4x II teleconverter. 

ISO 500, 1/500, f/8.0.
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CONFIGURING BRIDGE

Before you enter metadata, you need to configure Bridge. Keep 

in mind that Photoshop/Bridge is a complex pair of programs. 

The configuration of Bridge (and Photoshop) that is best for you is 

a matter of personal preference. As a result, I will explain how I do it 

and you can then try my approach, modify it to meet your particular 

needs, or, of course, disregard it entirely.
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White-crowned Sparrow, Santa Clara Ranch, Starr County, TX. Canon 
7D camera, Canon 600mm f/4.0 lens, Canon 1.4x II teleconverter, 

ISO 500, f/14, 1/100.

	 Configuring Bridge is a three step process. 

	 Step One: With Bridge open, access “Preferences” (Ctrl/Cmd K 

or Edit > Preferences...). This opens a page with topics listed on the 

left and their options on the right, as shown at the top of page 20. In 

the first topic (“General”), click the left (darkest) box and move the 

two sliders (“User Interface Brightness” and “Image Backdrop”) to 

Black. Leave “Accent Color” (used to highlight selected items) at 

“Default”. Uncheck all of the check boxes (3 on MACs; 2 on PCs), 

and set “Number of Recent Images to Display” to 25. 

	 Click on the second option (“Thumbnails”), as shown at 

the bottom of page 20. Leave “Do Not Process Files Larger Than:” 

at 1000 MB. (You are unlikely to deal with files of this size.) 

I then select the following four options from the drop down lists: 

Copyright, Color Profile, Depth, and Size. This results in these 

four data sets being added to your thumbnail displays. Finally, click 

the “Show Tooltips” box. There are 8 more sets of options, but I 

suggest you leave these as they are (i.e.: their defaults).

	 Step Two: When Bridge is first opened, nine panels are displayed: 

Favorites, Folders, Filter, Collections, Export, Content, Preview, Metadata, 

and Keywords.

	 Close all but Folders, Metadata, and Content by going into “Window” 

on the Menu Bar (top of Bridge) and unclicking Collections, Exports, 

Favorites, Filter, Keywords, and Preview. (Content cannot be 

closed, so is not listed.) You can only click or unclick one item at
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Eastern Meadowlark, Canoe Creek Rd, Osceola County, FL. Canon 7D camera, 
Canon 600mm f/4.0 lens, Canon 1.4x II teleconverter, 

ISO 500, f/5.6, 1/640, EC +2/3.
Cedar Waxwing, South Padre Island, Cameron County, TX. Canon 

1D Mark II camera, Canon 600mm f/4.0 lens, ISO 800, f/4.0, 1/100.

a time, so this process takes a while and leaves only Folders, Metadata, 

and Path Bar checked. (The Path Bar is not a panel; rather, it shows 

where you are on your hard drive and appears as a line above the left 

panel.) Drag the Metadata tab into the left panel with the Folders 

tab. Finally, drag the right side of the content panel all the way to 

the right. The result is shown on pages 25-26. 	

	 Step Three: You will want your new workspace to appear when 

you next open Bridge. To do this, go to Window > Workspace > New 

Workspace... . This opens a dialog in which you name your 

workspace. Check the two boxes and click Save.

ADDING METADATA

There are two steps to adding metadata: via Tools > Append 

Metadata and via the Metadata tab. Generally, you will need 

to do both as the former encompasses general information that you 

will probably want to add to all of your images while the latter 

encompasses information specific to a given image or to a given 

group of images.

	 NOTE: Enter your Append Metadata information before your 

Metadata tab information. If not, the Append Metadata information may
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overwrite some or all of your Metadata tab information and you will 

then have to reenter the latter.	

	 To enter data via Append Metadata you need to have completed 

a Metadata Template. There are two ways to do this. The first is via 

Tools > Create Metadata Template...; the second is via the Metadata 

tab. Either way, the result will be the same, and you need only do one. 

	 When you access the Metadata Template, you are presented with a 

blank template. At the top, you are asked to name it. Below this are a 

various number of sections, depending upon the version of Photoshop 

CS6 you have. See some examples on the facing page.

	 The IPTC Core is the only section relevant to wildlife/nature 

photography. It allows you to enter your name, contact information, 

copyright status, and terms of usage. By completing this section and 

appending these metadata to your RAW images, Photoshop/Bridge 

will automatically add them to each new iteration of these images! 

Thus, you only have to enter them once. Were you to do so on your 

processed images, the time involved would be increased as it takes 

longer to add metadata to larger files.

	 The IPTC Extension focuses on photographing various copyrighted 

materials and models. Hence, it includes categories such as the 

name of models or artworks, model age, property release status, etc. 

Obviously, if any of these are relevant to your work, you may well 

want to fill them in. However, by their very nature, they would 

have to be changed for each shoot. 



29 30

Rose hip, Alaska Botanical Gardens, Anchorage, AK. Canon 7D camera, 
Canon 70-200mm f/2.8 lens @ 200mm, ISO 2000, f/2.8, 1/1000.

	 The fact that you can create and name multiple templates means 

that this section can be useful for those of you who shoot such subjects. 

Likewise, if more than one person uses your computer, having 

templates for each user can be helpful.

	 The Metadata template can also be accessed via a small icon 

(a down facing arrowhead) on the Metadata tab. Click on this icon 

to access a pull down menu including the same Create Metadata 

Template.... Again, there is no need to duplicate your templates, 

so complete only one. Finally, you can edit your template via Tools > 

Edit Metadata Template, or via the same option from the Metadata 

tab pull down menu.

	 To enter your metadata, highlight the images at issue in Bridge. 

Then go to Tools > Append Metadata and click on the name of the 

template that contains the metadata you wish to add to these 

images. 

	 Should you and someone else be on the road and one of you 

have computer problems, that person can enter his/her metadata by 

having both of your templates on each other’s computer. 		       

	 After entering these metadata, go to the Metadata tab which 

has expandable subtabs. These are accessed by little arrowheads at 

the left of each. The only one I enter data into is the IPTC Core. 

Cameras automatically enter the data into File Properties, Camera 

Data (Exif), and Camera RAW. The rest are not relevant to wildlife/ 

nature photography. 



Common Ground-Dove, Campo Viejos Ranch, Starr County, TX. Canon 
1D Mark III camera, Canon 600mm f/4.0 lens with Canon 2.0x II 

teleconverter. ISO 250, f/8.0, 1/250, EC -1/3. 
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	 Click the arrowhead left of IPTC Core to expand it (if it is not 

already opened). 	

	 If you are adding metadata to older images, you should enter 

the date the images were created. If you are not certain of the date 

of one or more of your images, open the File Properties section 

and the date(s) will be there. 

	 If you have more than one image highlighted, the date may 

not be visible even if the highlighted images were shot on the same 

day. Instead, “(Multiple Values)” will appear. The reason for this 

is that the “Date Created” entry includes the time, to the second, 

as well as the date. I suggest that you should also enter data in the 

following areas: Sublocation, City, State/Province, and Country. 

	 Once these data are entered, move your cursor over the Content 

panel and a dialog will appear asking if you want to apply them. If 

so, click Apply. 

	 If you want to edit these metadata, including any entered via 

your template, do so by clicking on the entry in the Metadata tab’s 

IPTC Core and making your edits. The same process works to add 

or edit metadata for your other images. Finally, even though you 

have all your new images in two folders, on different hard drives, I 

suggest you only enter the metadata on one set. The only purpose 

of the “Copies” set is as an emergency backup should something 

happen to the first set, and you will delete the second set once 

you have successfully finished with the first one.
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Broad-winged Skipper, Goshen, Cape May County, NJ. Canon 1D Mark IV 
camera, Canon 100-400mm f4.5-5.6 lens @ 400mm, ISO 500, f/11, 1/250.

IMAGE EDITING

Now that you have entered your metadata for your new images, 

it is time to edit them. This is an ongoing process. In fact, as 

I create more images, I periodically reedit them to delete similar or 

weaker ones. Also, the more processed images you have, the longer it 

takes Bridge to open your folders. (Not so in Lightroom because 

it only saves instructions without processing the images until 

and unless you export them, and is a big reason some photographers 

prefer Lightroom to Photoshop/Bridge.)

	 Step One: Open the folder containing your new images. 

Click on the first one, and then press the Space Bar. This will 

enlarge the highlighted image to full screen size. 

	 Step Two: To see the rest of the images in this folder, use the 

right arrow key on your keyboard. Look at each image and mark for 

deletion, via the Delete key, those you want to eliminate. 

	 Step Three: During your initial edit, delete those images that 

are obvious rejects (e.g.: out of focus, no subject, etc.) or for which you 

have better versions. 		

	 Step Four: I suggest that you then perform another 

edit. Your criteria at this point will vary with the number and quality 

of images you have of a given subject. For example, if you have a 

number of good images of Mallards, you are more likely to delete 

additional images of this species then of subjects of which you have 

few or no good shots. 	

	 There is no formula for how many times you should edit your 

images, so do it until you have removed all that are not up to your 

standards. As you develop as a photographer, you undoubtedly will become 

more critical of your work and you will delete more of your shots.

	 An old film days adage says that the difference between a professional 

photographer and an amateur is the size of his/her waste basket (i.e.: pros 

had bigger waste baskets as they discarded a higher percentage of their 

images). Chas Glatzer (shootthelight.com) has updated this saying 

by noting that the difference today is that the Delete key on a pro’s 

computer is more worn than is the one on an amateur’s computer.
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Great Egret, San Antonio, TX. Canon 
1D Mark II camera, Canon 600mm 

ISO 800, f/4.0 lens, f/4.0, 
1/250, EC -2/3.
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Green Jay, Santa Cruz Ranch, Starr 
County, TX. Canon 7D camera, 
Canon 600mm f/4.0 lens, ISO 1600, 

f/5.6, 1/640.

RENAMING IMAGES

Digital cameras invariably provide a seemingly meaningless 

alpha/numeric “name” for each image. Not surprisingly, 

these appellations do not lend themselves to my organizational 

structure, and I suspect that this is also true for you. Thus, I suggest 

you name your images in a manner meaningful to you. However, 

before doing so, three issues should be addressed: 1) when is it best 

to rename your images, 2) what renaming system should you use, 

and 3) what is the most efficient way to rename your images?

	 You now have a series of edited images to which your metadata 

have been added, and which contain the alpha/numeric names given
to them by your camera(s). 

	 The only change I suggest you 

make at this time is to give them 

new names. By doing this now, all 

new iterations of each image will 

have the same new name. 

	 Again, should you wait until 

you have multiple versions of each 

image, you will have to rename 

each individually. As with metadata, 

renaming processed files takes longer 

than naming RAW files because 

they are larger.

	 The next issue is what naming 

system should you use. This is 

very important as it will become 

the basis of your organization. 

	 As a wildlife photographer, I 

name each image based upon the 

species that is the subject of the 

image, or the location for my scenic 

and landscape images. However, 

it is not feasible to name all my 

Peregrine Falcon images “Peregrine 

Falcon” as this would result (if my 

computer allowed it) in all my 

Peregrine shots having the same 

name. Obviously, this would not 

work. 

	 To resolve this, I add a six 

digit number to the name. There 

is no magic behind my using six 

digits, or for the fact that I start 

with number 000100; it’s just the 

way I do it. If you want to do the 

same, be my guest. If you prefer a 

different system, go for it.



Silver-Spotted Skipper, Longwood Gardens, 
Kennett Square, PA. Canon 1D Mark 
IV camera, Canon 100-400mm f/4.5-5.6 
lens @ 400mm, ISO 500, f/8.0, 1/400.

East Glacier, MT. Canon 1D Mark III 
camera, Canon 28-70mm f/2.8 @ 48mm, 

ISO 400, f/14, 1/160, EC -1/3.

Green Heron, Indian Ridge 
B&B, Mission, TX. Canon 1D 

Mark II camera, Canon 75-300mm 
f/5.6 lens @ 300mm, ISO 400, 

f/8.0, 1/125, EC -1/3.
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	 For example, I currently have no Smith’s Longspur images. Were I 

to shoot this species, I would rename the first image Smiths 

Longspur 000100. I would do this in four steps:

	 Step One: Highlight all of the images you want to name using the 

same species or location prefix. If you have 18 Smith’s Longspur 

images that you want to rename, highlight all of them in the Content 

panel of Bridge. 

	 Step Two: Bridge’s Batch Rename tool (Tools > Batch Rename...) 

makes renaming easy. (See screen capture below.) I ignore Batch Rename’s 

Preset menu. From the Destination Folder option, choose Rename in 

same folder. Below this is the New Filenames section which has an 

optional number of boxes.



Ludwigia, Longwood Gardens, 
Kennett Square, PA. Canon 7D 

camera, Canon 100-400mm f/4.5-5.6 
@ 400mm, ISO 800, f/20, 1/125.

Mountain Bluebird, Alcova Res, WY. Canon 1D Mark IV camera, Canon 
600mm f/4.0 lens, Canon 2.0x III teleconverter, ISO 500, f/8.0, 1/1600.
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	 You can add or remove boxes as desired by clicking on the “+” 

to add or the “-” to remove a box, but you only need two boxes. In 

the first box, select Text from the drop down menu which causes a 

box to open to its right. In this box, for our Smith’s Longspur 

example, type Smiths Longspur . (Note the space after the name.) In 

the second box, select Sequence Number. This causes two boxes to 

open to its right. In the first one, type 100 while in the second one 

select Six Digits from the drop down options. (By selecting six digits, 

Batch Rename will add three zeros in front of the 100.) 

	 Step Three: Ignore the next section (Options). However, 

make sure the last section (Preview) shows that the New filename is 

what you want it to be.

	 Step Four: Click Rename and you are done.

	 But what if you have named 

images of a species and you now 

have new ones of the same 

species? 

	 In that case, go to the folder 

holding the original RAW files 

for that species, locate the last 

named image of that species, and 

copy the name (highlight it and 

press Ctrl/Cmd C). Open your 

new images of that species in 

Batch Rename and paste (Ctrl/

Cmd V) the name in the box to 

the right of the “Text” box. Cut 

(Ctrl/Cmd X) the number  portion 

of this name and paste (Ctrl/

Cmd V) it in the box to the right 

of the “Sequence Number” box, 

increase the number by one, and 

click Rename. This results in the 

names of your new images being 

synchronized with the names of 

your already existing images of 

that subject.
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Devil’s Club, Kenai Peninsula, AK. 
Canon 7D camera, Canon 70-200mm 
f/2.8 lens, Canon 2.0x III teleconverter 

@ 225mm, ISO 800, f/5.6, 1/100.

CONVERTING TO DNG
	

A number of today’s photography contests require, in addition 

to your processed images, that you submit the images as 

they came out of your camera, except for changed names. As a result, I 

store the renamed RAW files that come out of my cameras in their own 

folders. Also, virtually all camera companies use proprietary (i.e.: 

secretive) RAW formats. However, these companies have no obligation 

to support their older RAW formats. This, in turn, suggests that, 

at some point, you may have any number of RAW files that will be 

as usable then as 8-track audio tapes are today. 	

	 Because of this situation, 

Adobe created an open RAW 

format called DNG which Adobe 

claims it will support forever. DNG 

files are also 10-15% smaller than 

the RAW files that come out of 

my Canon cameras. Thus, I 

suggest that you also create and 

save DNG versions of each of 

your images as follows:

	 Step One: Highlight all 

your images in Bridge, and press 

Ctrl/Cmd R. 

	 Step Two: This opens the Adobe Camera RAW (ACR) dialog. 

Click the Select All button in the upper left corner and the Save Image... 

button in the lower left corner to open the “Save Options” dialog (see 

below). 	

	 Step Three: Select “Save in Same Location” from the Destination 

drop down menu. The File Naming section has two sets of boxes. Select 

“Document Name” from the first drop down menu. Leave the other 

boxes and Begin Numbering box blank. Choose “.dng” from the 

File Extension drop down menu. In the Format section, select “Digital 

Negative” from the first drop down menu, “Camera RAW 6.6 and later” 

from the second drop down menu, and “Medium Size” from the third 

drop down menu. Leave Embed Original Raw File box unchecked. Click 

the Save button and you are done.
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Great Blue Skimmer; Cape May County, NJ. Canon 7D camera, Canon 300mm 
f/2.8 lens, Canon 2.0x II teleconverter, ISO 500, f/5.6, 1/125.

Part 2: 

PROCESSING YOUR IMAGES

As noted in the Introduction, if you shoot JPEGs, there is little 

processing you can do because the JPEG algorithm has permanently 

deleted 7/8 (87.5%) of the data your camera captured. As such, the 

following discusses how to process RAW images.

CONFIGURING ADOBE CAMERA RAW (ACR)

Before you process your RAW files, you should configure your 

ACR (which used to be called Adobe Raw Converter or ARC). 

	 Step One: When you first open your ACR (Ctrl/Cmd O), click 

on the alpha/numeric line at the bottom center of the frame. (See red 

arrow on pages 45-46.) This will open ACR’s Workflow Options dialog. 

(See capture on facing page.) From the Space drop down menu, 

select “Adobe RGB (1998)”; from the Depth drop down menu, select 

“16 Bits/Channel”; from the Size drop down menu, select the option 

that has neither a “+” nor a “-” sign next to it (this will vary 

depending upon your camera); in the Resolution area type “240” and 

select “pixels/inch”; from the Sharpen For drop down menu, select 

“None”; and from the Amount drop down menu, select “Standard”. 

Uncheck the bottom box, and click OK. 

	 Step Two: You are now back to the main ACR page. Check the 

two small boxes at the upper corners of the Histogram at the top

of the right column of ACR (top of page 46). When checked, these 

boxes will cause exposure warnings, when warranted, to highlight 

parts of your images. Areas that are blocked (i.e.: have no detail in 

dark areas) will be highlighted in blue; areas that are blown out (i.e.: 

have no detail in bright areas) will be highlighted in red. There will 

also be lines running up one or both sides of your Histogram.
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Cape May Point Lighthouse, Cape May Point SP, NJ. Canon 7D camera, 
Canon 300mm f/2.8 lens, ISO 500, f/5.6, 1/1000, EC +1.

HOW TO

OPENING YOUR RAW IMAGES

Although ACR has evolved into a subprogram that offers many 

options, I rarely, if ever, do more in it than address white balance and 

exposure issues, if either are needed.

	 Step One: Open your RAW (DNG) images (Ctrl/Cmd O) 

in Photoshop’s ACR. (See the screen capture on pages 45-46.) 

Photoshop’s ACR is identical to Bridge’s ACR. (I suggest you 

open ACR in Photoshop at this point because you will be processing 

your images in that program. When, on page 41, I suggested that 

you open images in Bridge’s ACR to make DNG copies, I did so 

because there was no need to open a second program.)

	 Step Two: Again, the Histogram will be at the top of the right 

column. Below it is a row of tabs providing access to various tool sets. 

However, the only set I suggest you use are in the Basic tab set which 

will be open by default. These tools consist of a White Balance drop 

down box, three sets of sliders, and “Auto” and “Default” buttons.

	 Step Three: Your images will appear in a column along the 

left edge. They may take a while to load, depending upon your 

computer and the number of images involved. (If you open only 

one image, it will appear in the main viewing area of ACR, and 

there will be no left column. See capture at the bottom of page 52.) 



Loggerhead Turtle, Wilmington Canyon off Cape May County, NJ. 
Canon 7D camera, Canon 300mm f/2.8 lens, ISO 400, f/2.8 @ 1/3200.
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	 Step Four: Scroll through your open images using the down 

arrow key on your keyboard. Initially, look to see if your images have 

any white balance issues. In other words, look to see if any of your 

images have an undesired color cast (an overall tint that you do not 

want). Remember, if you are shooting a sunset, you will want to keep 

the color cast as that is what causes the reddish sunset glow. Should 

you wish to make a change, you have two ways to do this. The first 

is the White Balance menu which contains nine options: “As Shot”, 

“Auto”, “Daylight”, “Cloudy”, “Shade”, “Tungsten”, “Fluorescent”, 

“Flash”, and “Custom”. Make a selection based upon the conditions 

under which you created the image. However, try experimenting to 

see what your images look like under each option. You can always 

return to your image’s original look by selecting “As Shot”. 

	 The second is the sliders just below the White Balance drop down 

menu. The Temperature slider controls the blue/yellow continuum. 

If your image has an undesirable blue cast, move this slider to the 

right; if it has an undesirable yellow cast, move it to the left. The Tint 

Slider controls the green/magenta (reddish) continuum. If your 

image has an undesirable green cast, move this slider to the right; if it has 

an undesirable magenta cast, move it to the left. Again, you may wish 

to experiment with these sliders to see what they do. Keep in mind, 

you can always return your image to its original look by selecting “As 

Shot” from the White Balance drop down menu.

	 Step Five: The main use I suggest for ACR is to correct exposure issues. 

If there are areas of your images that are underexposed (blocked), 

they will be highlighted in blue. The Histogram will also show a line 

climbing up its left edge. The color of this line will tell you what 

channels are blocked (e.g.: if the line is blue, only the blue channel 

is blocked; if yellow, the green and red channels are blocked; etc.) If 

there are areas that are blown out, they will be highlighted in red. The 

Histogram will also show a line climbing up its right edge, and the 

color of this line will tell you what channels are blown out (e.g.: if the 

line is red, only the red channel is blown out; if cyan, the green and 

blue channels are blown out; etc.) If there is a white line running up 

either or both sides of the Histogram, all 3 channels are blocked and/

or blown out and you have no data in the darkest and/or lightest areas 

of your image.
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	  Step Six: Below the Tint slider is a line, and below that 

line are two underlined words: “Auto” and “Default”. If you 

click “Auto” it will apply an exposure “correction” based upon an 

algorithm in ACR. Try it, and if you like it, keep it. If not, click 

“Default” and your image will be returned to its prior state.

	 Step Seven: The next section, consisting of 6 sliders, are 

new or modified in Photoshop CS6 and are based on much 

improved algorithms. All of these sliders now start in the middle 

of their ranges so that they can be decreased as well as increased.

	 Opening a RAW image that has been opened in an older 

version of ACR, opens it in that older version. ACR notes this with 

an exclamation point (the red arrow on page 52.) Click it to change 

to the new ACR, and apply its settings. Click “Cancel” to undo this.

	 The first slider, “Exposure”, adjusts mid-tones. (It used to adjust 

mid-tones and highlights which made it a rather blunt instrument.) If 

your image is a little bright, moving this slider left may correct the 

issue. If your image is overexposed, you can adjust it with the 

“Highlights” slider, which essentially affects only the brighter areas 

of your image. If this does not resolve your issue, then add a “Whites” 

slider adjustment by moving it to the left. 

	 If your image is too dark, your can slide the “Exposure” slider to 

the right. However, as discussed in the “Why-Do-It-This-Way” section, 

lightening an image often increases noise (pixels of inappropriate color or 

tone). Darkening an image rarely has this effect.

	 Step Eight: The “Blacks” slider allows you to darken or lighten 

the darkest shadows while the “Shadows” slider allows you to darken 

or lighten the less dark shadows. A common misuse of the Blacks slider 

is to remove minor blocking. The problem is that this can reduce 

image contrast. True, blocked areas can be a problem. However, as 

discussed in “Why-Do-It-This-Way”, there are relatively few data 

in darker areas. As such, most images look better with blacker 

blacks. Also, the darker areas rarely contain the image’s subject. 

However, as is true with all artistic “rules”, they should be viewed as 

guides not mandates, and you should feel free to ignore them when 

you have a good reason to do so.

 



Golden-fronted Woodpecker, Santa Cruz Ranch, Starr County, TX. 
Canon 40D camera, Canon 500mm f/4.0 lens, Canon 1.4x II 

teleconverter, ISO 400, f/16 @ 1/400, EC -1/3.
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Ghost Crab standoff, Cape May Point SP, NJ. Canon 1D Mark IV camera, 
Canon 600mm f/4.0 lens, Canon 2.0x III teleconverter, ISO 1600, f/16 @ 1/800.

	 Step Nine: The “Clarity” slider adds snap to your images by 

increasing contrast in the mid-tone areas. Use of older versions of this 

slider often resulted in halos or ghosting, but the new algorithms have 

gone a long way to reduce these artifacts.

	 Step Ten: The “Vibrance: slider allows you to increase or decrease 

the intensity of the hues (colors) in the areas of your images that are 

not already rather saturated. This is different from the “Saturation” 

slider which increases or decrease the intensity of all of the hues which 

often results in very unnaturally looking images. While this may be 

desireable in some photographs, this is rarely the case with nature or 

wildlife images.

	 Step Eleven: When you have done all of the above for each 

image, click the Select All button in the upper left, and then the Open 

Image button under the right column in the ACR. This will open your 

images in Photoshop where you will do the rest of your processing.
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El Mecca Cascade, San Luis Potosi, MX. 
Canon 10D camera, Canon 28-70mm 

f/2.8 lens, ISO 100, f/22 @ 1/45.

 PROCESSING YOUR 

RAW IMAGES

The images that survived 

your editing process should 

now be named, your original 

RAW versions moved to your 

“File” subfolder, at least some 

of your DNG versions adjusted 

for color balance and exposure, 

and the last opened in Photoshop. 

You are now ready to begin the 

heart of your image processing. 

However, I suggest you first 

configure Photoshop so that it 

is setup the way you want it.
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CONFIGURING PHOTOSHOP

My configuration may not be best for you, 

so feel free to accept, modify, or reject 

it. Configuring Photoshop is a two part process. 

The first is via Edit > Preferences > General 

(or via Ctrl/Cmd K). 

	 NOTE: Some Preferences pages are not 

the same on PCs as they are on MACs. The 

differences are minor and do not affect the way 

Photoshop operates. (All screen shots herein 

are from a PC, but this should not be an issue.)

	 Step One: Open Preferences in Photoshop 

by either of the methods noted above.

	 Step Two: Preferences has ten parts. The 

first, “General”, has three drop down menus 

at the top, (see pages 55-56). From the Color 

Picker, select “Adobe”; from the HUD Color 

Picker, select “Hue Strip (Small)”; and from 

the Image Interpolation, select “Bicubic (best 

for smooth gradients)”. In “Options” check 

the 3rd through 7th and the last 4 boxes. Do 

not check the History Log check box as these 

data are of little value.
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	 Step Three: The next page is “Interface”. (See 

pages 57-58.) The first section is called “Appearance”, 

and has 4 color boxes. Select the 2nd box from the left 

(2nd darkest). Next are 3 pairs of drop down menus. 

Select “Default” and “Drop Shadow” from the first 

two pairs and “Black” and “Drop Shadow” from the 

3rd pair. Below this are 8 check boxes. Check the 

2nd, 3rd, and last 3. MACs also have an “Enable 

Gestures” check box which is not relavent to 

wildlife/nature photography. Finally, for this page, 

select “English” and “Small” from the last two drop 

down menus.

	 Step Four: The 3rd page, “File Handling” (below), is different in the PC and MAC 

versions. Both have two drop down menus in the File Saving Options section at the 

top. Select “Always Save” from the Image Previews drop down. If you use a PC, select 

“Use Lower Case” from the File Extension menu. If you use a MAC, check all of the 

boxes in this section, and choose “Always” from the second menu. 

Twelve-spotted Skimmer, Cape May County, NJ. Canon 7D 
camera, Canon 300mm f/2.8 lens, Canon 2.0x II teleconverter,

ISO 500, f/5.6, 1/1000.
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	 Check the Save As to Original Folder box 

which appears in both PC and MAC versions. 

	 The “File Compatibility” section can be confusing 

as it consists of two parts: the Camera Raw Preferences... 

button and the four items below it. 

	 Clicking the Camera Raw Preferences... button 

opens a dialog (page 62). In the “General” section, 

select “Sidecar ‘.xmp’ files” and “Preview images 

only” f rom the drop down menus. In the “Default 

Image Settings“ section, check only the second box. 

In the “Camera Raw Cache” section, leave Maximum 

Size at 1.0 GB and leave Select Location as it is. 

In the “DNG File Handling” section, uncheck 

both boxes. In “JPEG and TIFF Handling” section, 

select “Automatically open JPEGs with settings” 

and “Automatically open TIFFs with settings”. 

Click OK and you will be returned to the File 

Handling page. 

	 Click the 1st and 4th check boxes below the 

Camera Raw Preferences... button (page 60), and 

select “Ask” from the Maximize PSD and PBD File 

Compatibility drop down menu. Do not check the 

Enable Adobe Drive box, but increase the number of 

Recent File List Contains to 30.
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	 Step Five: The “Performance” page (pages 63-

64) helps maximize the efficiency of Photoshop. 	

	 I have 8 GB of RAM and use the 64 bit version 

of Photoshop CS6. This allows me to allocate 

70% of my RAM in the “Memory Usage” section. If 

you have less RAM or use the 32 bit version, you may 

not want to allocate as much as it may slow down 

your computer. 

	 In the “History & Cache” section, I raise the 

History States to “75”, and leave the cache level at 

“4” and the Cache Tile Size at “128K”. Again, the 

resources of your computer should be considered. In the 

“Scratch Disk” section you should, if possible, select 

a hard drive other than the one on which Photoshop 

is loaded. In the “GPU Setting” section, check the 

Enable OpenGL Drawing box.

	 Step Six: In the “Cursors” page (pages 65-

66), I select Full Size Brush Tip and Show Crosshair 

in Brush Tip in the “Painting Cursors” section, and 

Precise in the “Other Cursors” section. These are 

matters of personal preference, so my choices may 

not be best for you

	 Step Seven: In the remaining pages (Transparency 

& Gamut; Units & Rulers; Guides, Grids & Slices; 
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Plug-Ins, and Type), leave all the settings in their 

default positions, and click OK.

	 The second part of configuring Photoshop 

involves determining which panels you want active 

and where you want them placed on your monitor. 

My preferences are shown on pages 67-68.

	 Step One: Unlike Photoshop CS5, CS6 

offers 4 workspace presets: Motion, Painting, 

Photography, and Typography. To access these 

options, go to Window > Workspace and click 

the Photography preset. This should activate two 

panels. 

	 The former contains the History and Actions 

tabs while the latter contains the Layers, Channels, 

and Adjustments tabs. (If not all are active, click 

on the missing one(s) in Window.) Next, combine 

the tabs into the two panels noted above, if they 

are not already so placed. Finally, check Options 

and Tools. 

	 The Options bar is the next to the top line on 

PCs and the third from the top on MACs. Its 

content varies with the tool activated. 

	 The Tools bar is the long, thin vertical panel 

that allows you to access various tools. 
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American Snout, Indian Ridge B&B, Mission, TX. 
Minolta Dimage 7i camera, 49.1mm, ISO 100, f/4.5, 1/180.
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	 Should you prefer a double wide Tools bar, click 

the double arrows at the top of the Tools bar. To 

return to the long, thin option, reclick the double 

arrows. Keep in mind that you can also access specific 

tools by using the appropriate keyboard shortcut. 

	 If you are using a MAC, also check Application 

Frame (which PCs automatically have active).

	 Step Two: The last issue is where on your monitor 

you want to place your panels. I place the 2 panels to the 

right; and the Tools bar to the left. Again, see pages 67-68. 

As with all configuration aspects of both Bridge and 

Photoshop, the best setup for you is the one you prefer.

Hummingbird Clearwing; Cape May County, NJ. 
Canon 7D camera; Canon 300mm f/2.8 lens; Canon 2.0x II

teleconverter; ISO 500; f/5.6; 1/1000.



Left: Cloudless Sulphur, Santa Cruz 
Ranch, Starr County, TX. Canon 40D 
camera, Canon 180mm f/3.5 macro lens, 

ISO 400, f/6.3, 1/299, EC -1/3.
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Right: Brown Pelican. Port Aransas 
Birding Center, TX. Canon 1D Mark 
II camera, Canon 600mm f/4.0 lens, 

Canon 1.4x II teleconverter, 
ISO 200, f/5.6, 1/800, EC -2/3.

PRE-PROCESSING TASKS

It is not unusual to want to 

clean up or otherwise make 

adjustments before you process 

your images. The number and 

variety of such actions are 

beyond the scope of this book, 

but I will now address a few of 

the more basic ones.

CROPPING YOUR IMAGES

Prior to CS6, Adobe had not significantly changed its Photoshop 

Crop Tool for many iterations. This seemed more than a bit 

strange as Lightroom 3 (the current version is Lightroom 4) has a 

sophisticated Crop Tool. However, with CS6, Adobe has finally upgraded 

Photoshop’s Crop Tool.

	 Step One: Open an image, such as the Wilson’s Plover (top of 

page 73), that you wish to crop. 

	 Step Two: Open the Crop Tool by clicking its icon on the Tool 

Bar (5th from the top) or pressing “C” on your keyboard. Note that 

the image is now automatically surrounded by the crop outline, and 

that it has handles in each corner and in the middle of each side. When 

you click on one of these handles, the Rule of Thirds grid appears. 

	 Step Three: Most of the time, I retain the same aspect ratio 

(the ratio of length to width) when cropping. The easiet way to do 

this is to right click on the image and select “Original Ratio”. You can 

also select “Original Ratio” from the drop down menu in the upper left 

of CS6 (below the word “Edit”). Should you wish to not be restricted 

to any particular aspect ratio, select “Unconstrained” from the same 

drop down menu or from the right click list of options.

	 Step Four: Drag any of the 

handles to achieve the crop you 

desire. Note that the area to be 

eliminated will be grayed out (see 

bottom of page 73).

	 Step Five: To complete the 

crop, either press the “enter” (PC) 

or “return” (MAC) key, or select 

“Crop” (next to the last choice) 

from the right click option (see 

top of page 74). 
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	 If you are only going to crop a small portion of an image, and 

the image is nicely exposed and in sharp focus, you may wish to 

retain not only the original aspect ratio, but its original resolution 

as well (its PPI - pixels per inch). 

	 Step One: Open the image you wish to crop.

	 Step Two: From the right click options, select “Use Front 

Image Size & Resolution”.

	 Step Three: Move one or more of the corner or edge handles 

until the desired crop is achieved.

	 Step Four: Again, to complete the crop, either press the “enter” 

(PC) or “return” (MAC) key, or select “Crop” (next to the last choice) 

from the right click option.
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	 In accord with its recognition that many of us prefer to work 

with our images against a dark background, Adobe has moved 

another crop option from Lightroom into Photoshop CS6. It is called 

“Lights Out Cropping” and completely hides the area that cropping 

normally grays out. 

	 To activate this option, press “H” on your keyboard after you 

have moved a crop handle. (If you press “H” before moving a crop 

handle, you will activate the Hand Tool.)

	 Many like this option as it removes visual distractions. In fact, 

you can remove even more such distractions by then pressing the 

“Tab” key which hides Photoshop’s panels. These panels can be 

made to reappear by again pressing the “Tab” key.

	 As noted, some images look better if they are not cropped to 

a 3:2 aspect ratio. The image of River Otters at the bottom of p. 

75  is an example. The image at the bottom of p. 76 is the same 

photo cropped to better display the elongated nature of otters. To 

do this, follow these steps:

	 Step One: Instead of selecting “Original Ratio” from the drop 

down menu or from the right click options, select “Unconstrained”. 

	 Step Two: Drag any number of the corner or side handles until 

you have created the crop you desire. If you are not happy, redrag 

the handles until you are happy. Again, either press the “Enter” (PC) 

or “return” (MAC) key, or select “Crop” (next to the last option) from 

the right click options.

	 Another crop action adds canvas.

	  The Baltimore Oriole image at the top of p. 77 has a problem, the 

subject is too close to the top of the frame. Fortunately, it is easy to add 

sky above the oriole, and then to 

	 As noted, some images look better if they are not cropped to a 

3:2 aspect ratio. The image of River Otters at the bottom of page 

75  is an example. The image at the bottom of page 76 is the same 

photo cropped to better display the elongated nature of the otters. 

To do this, follow these steps:

	 Step One: Instead of selecting “Original Ratio” from the drop 

down menu or from the right click options, select “Unconstrained”. 

	 Step Two: Drag any number of the corner or side handles until 

you have created the crop you desire. If you are not happy, redrag 

the handles until you are happy. Again, press either the “enter” (PC) 

or “return” (MAC) key, or select “Crop” (next to the last option) from 

the right click options.

	 Another crop action permits you to add canvas.

	 The flying Baltimore Oriole image (top of page 77) has a problem, 

the subject is too close to the top of the frame. 

	 Fortunately, it is easy to add space (canvas) above the oriole, and 

then to fill it in with sky that nicely matches the rest of the sky in the 

image.
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	 Step One: Open the image and activate the Crop Tool (5th 

from the top in the Tool bar or press “C” on your keyboard).

	 Step Two: Select “Original Ratio” from the drop down menu, 

or from the right click list of options. Then click and drag the image 

itself (not one of the handles) down until the amount of space 

(extra canvas) you want is added above the original image. Refine 

the placement of the subject by continuing to move the image 

and/or handles as desired (see bottom image page 77).

	 Step Three: Activate the Magic Wand Tool (2nd option, 

4th slot from the top of the Tools bar). Click in the extra canvas 

you’ve added. This selects this area, which is shown by the dashes 

moving along the edges (the “marching ants”).
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	 Step Four: Click on Select > Modify > Expand, enter “5” 

in the box (you can vary this value as desired), and click OK.

	 Step Five: Open the “Fill” dialog (Edit > Fill or, on PCs 

only, Shift F5). Select “Content Aware” from the top drop down 

menu, and click Okay. It may take a few moments, but this results 

in the new canvas area being filled in with sky that seamlessly 

(or nearly so) matches the rest of the sky in the image.  

	 As nice as content aware fill is, it does not always work as 

desired. Generally, it works best when the area to be filled is 

not detailed, such as the sky in our Baltimore Oriole example. 

However, don’t be afraid to try it in other situations as it can 

work quite well when least expected. 

	 If it does not work as you want it to the first time, try it 

again. If you are still not happy, use the Patch Tool to modify 

any area that needs tweaking.

	 The Patch Tool is the 3rd option, 7th slot from the top 

of the Tool bar. The 1st tool in this group is the Spot Healing 

Brush Tool. The Patch Tool is accessed by clicking and holding 

on the 1st tool in this group until a drop menu appears. Then 

click on the Patch Tool. 

	 With the Patch Tool active, draw a loose selection around 

any area you want to replace. Then click in the selected area 

and drag it to an area you want to use to replace the selcted 

area.

STRAIGHTENING YOUR IMAGES

Photoshop has traditionally considered straightening to be 

separate from cropping. However, the act of straighten an image 

moves part of the image outside of its useable frame. As such, the image 

must be cropped. 

	 The closeup image of the top of the Cape May Point Lighthouse 

(top of page 81) is obviously in need of straightening. I did the 

following to correct this problem:

	 Step One: I opened the image and acitvated the Crop 

Tool as note previoulsy. 

	 Step Two: I clicked the “Straighten” button (red arrow in 

the screen capture below).
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	 Step Three: I dragged with the straighten tool along a bar 

between the panes of glass (red arrow, bottom image, page 81). 

The longer your straightening line, the more likely your image will 

be straight. I released my mouse button and CS6 straightened 

the image. It also offered a proposed crop frame. (Again, bottom 

image, page 81.) If I had disliked this frame, I could have used 

one of the crop handles to adjust it, or I could have undone the 

crop by pressing the “Escape” key, and started over. 

	 Step Four: When I was satisfied, I pressed the “enter” key 

(the “return” key in MAC), or I could have selected “Crop” (next to 

the last choice) from the right click option list. That’s it. The image was 

straight and the excess areas were removed.
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SPOT REMOVAL

One of the realities of digital SLR (dSLR) photography is that 

as you change lenses, dust and/or other foreign particles get 

inside your camera, and some of these inevitably end up on your 

camera’s sensor. 

	 These spots show up most prominently on images with 

areas of clear sky, water, or similar smoothly colored surfaces. 

True, many modern dSLRs have dust removal functions, but 

these will not remove all foreign objects instantly from your 

sensor. As a result, virtually all digital photographers will discover 

that some of their images have unwanted spots. 

	 Fortunately, there is an easy way to deal with these: The Spot 

Healing Brush tool (most people simply refer to it as the Spot 

Healing Brush, as will I hereafter). This tool is activated by 

pressing “J”, or selecting the 7th tool from the top of the Tools 

bar (4th from the top on the left if your Tools bar is doubled). 

When the Spot Healing Brush is active, the Options bar (above the 

image) will show three “Type” options: Proximity Match, Create 

Texture, and Content-Aware.	

	 Select the Proximity Match option. Also, as a brush tool, you can 

change the size of the Spot Healing Brush via the bracket keys 

(press “[“ to make your brush smaller and press “]” to make your 

brush larger). 
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	 The Cinnamon Teal at the top of page 84 has spots in need 

of removal (red arrows).

	 Step One: Select a Spot Healing Brush sized to just slightly 

larger than the spot, and place your cursor so that it covers the spot.

	 Spot Two: Click on the spot. If it is not removed, try again. 

In one or two tries, the spot should be nicely removed.

	 Step Three: Some spots are so faint that they will not be visible 

until after you have processed the image. As a result, check each

image again after you have processed it to see if more spots have 

become visible. If so, reapply the process described above. The bottom 

image on page 84 is the result. (It also has been cropped.)

	 Some images, such as the Snow Goose on page 85, have spots 

from dust on the sensor (red arrows) and objects floating on the 

water (black arrows). Again, the Spot Healing Brush can be used 

to remove these distractions, as noted on pages 87-88. (Processing 

changed the water color in both of the final images herein.) 
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Golden-fronted Woodpecker, Campo Viejos Ranch, Starr County, TX. Canon 
1D Mark III camera, Canon 600mm f/4.0 lens, ISO 400, f/4.0, 1/125, EC -1/3.

	 Step One: Activate the Spot Healing Brush by pressing “J” or 

from the Tools bar (7th from the top of the Tools bar or 4th from the 

top on the left if your Tools bar is doubled).

	 Step Two: Adjust the brush size so that it is slightly larger than 

the first spot you want to remove. Remember, you can easily and quickly 

do this via the bracket keys (“[“ to make the brush smaller; “]” to make 

the brush larger), so change it for each spot you want to delete.

	 Step Three: For typical sensor dust spots, noted by the 

red arrows on page 85, place the Spot Healing Brush so that it 

completely covers the spot and click. If the spot is not removed after 

the first try, repeat the process.

	 Step Four: However, some of the foreign objects on the water 

are a bit elongated. While you can try to remove these by enlarging 

the Spot Healing Brush, this often results in adding undesired 

pixels from other areas of your image. Another approach is to select 

Content-Aware from the Options bar and draw as thin a line as you 

reasonably can to cover the offending area. The advantage of this 

approach, when it works, is that Photoshop CS6 replicates the pixels 

that would have been present had the object causing the spot not 

been there.

	 Step Five: When working in Content-Aware mode, it is not 

unusual for your first healing attempts to be unsatisfactory. If this 

is the case, retry it. While this does not work on all images, it does 

a nice job more often than not.

	 The result of using both Proximity Match and Content-

Aware is the image on page 86.
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Right: Great Egret, Alligator Farm, St. Augustine, Flagler County, FL. Canon 
1D Mark IV, Canon 300mm f/2.8 lens, Canon 2.0x III teleconverter, 

ISO 3200, f/5.6, 1/400.

PROCESSING IN LAB COLOR SPACE

You are now at the point where the actual processing of your 

images takes place. What makes my approach different from all 

of the others I have seen is two fold. First, I do the majority of it in 

Lab color space. This is a wholly non-intuitive color structure, but is 

very powerful and flexible. Second, as discussed shortly, I create and 

use editable actions (i.e.: recorded sets of instructions you can tweak). 

	 The problem with processing via actions is that every image is 

different, and actions can not directly take this into account. 

However, this potential problem is negated by the fact that my 

approach allows you to go back to any of your steps via your 

History panel and adjust the result(s). After you are sati s f i ed  wi th 

your Lab processing, I suggest you consider one or both of the 

enhance actions I discuss later to help add contrast, sharpness, and/

or warmth to your images.

	 You should now have some of the DNG image(s) you want to 

process open in Photoshop.

	 Step One: Convert your color space to Lab (Image > Mode > 

Lab Color). You will see no change in the image.

	 Step Two:  Copy  your  background layer (Ctrl /Cmd 

J or Layer > New > Layer via Copy).



Right: Phyrruloxia (left) and Northern Cardinal (right), Santa Cruz Ranch, Starr County, TX. Canon 40D camera, 
Canon 500mm f/4.0 lens, ISO 400, f/18, 1/320, EC -1/3. 
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	 Step Three: Your new layer will be used for a Shadows/Highlights adjustment (Image > Adjustments 

> Shadows/Highlights). You can rename this layer, but I suggest you do not as it will add another 

entry to your History but without the name you give it. Also, the action I describe below will always 

operate in the same order so there should be no confusion.

	 When you first open Shadows/Highlights, you will see a dialog with two sliders: Shadows and 

Highlights. Set both to 25%, and check the Preview and Show More Options boxes. This will open 

an expanded dialog. (See the screen capture to the right.) In the Adjustments area, set both Color 

Correction and Midtone Correction to +20; and, below that, set both the Black Clip and White Clip 

to 0.01%. Then click the Save As Defaults button, and OK to close this dialog and apply your changes. 	

	 This adjustment will now be visible on your open image. By clicking on the eye icon left of Layer 

1 in your Layers panel, you can turn this adjustment off. Click on the eye icon space to turn the adjustment 

back on. Do not be concerned, at this point, if the correction is more intense than you want. You can 

adjust it later.

	 Step Four: Click on the Curves icon in the Adjustments panel (the middle icon of top row). 

This will open a new Curves adjustment layer called Curves 1 in your Layers panel. 

	 If your Curves display shows 4 squares horizontally and vertically, I suggest you click on the very 

small (as in nearly microscopic) down facing arrowhead to the right of the word “ADJUSTMENTS” 

at the top of the Adjustments panel (green arrow, top capture, page 93). Click on Curves Display 

Options... which will open a dialog. Click on Pigment/Ink% and on the second icon to the right 

of “Channel Overlays”. Then click OK. This will return you to your open Curves adjustment layer 

with 10 squares horizontally and 10 vertically. Also, the Input and Output readings will range from 0 

to 100 instead of 0 to 255.
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	 From the second drop down menu, which says Lightness (red arrow, top capture, page 93), 

select “b” (red arrow, bottom capture, page 93) which will activate the “b” channel in Lab color space. 

This option allows you to vary the intensity of yellow and/or blue in your image. This is similar to the 

Temperature slider in ACR. However, that slider requires that if you increase yellow, you necessarily 

decrease blue and visa versa. Lab does not limit you in this manner.	

	 Step Five: Click on the small square at the lower left end of the curve (which is, at this point, a 

straight line) and move it to the right until the Input reads 10. You can do this either by clicking on 

and dragging the square, or by clicking on it and moving it with the right arrow key on your keyboard. 

This will increase the intensity of yellow in your image. Click on the small square at the upper right 

end of the curve and move it to the left until the Input reads 90 (top capture, page  96) .  This 

will tone down the effect of the yellow because it will increase the blue in your image. The result, as 

discussed in the “Why-Do-It-This-Way” section below, will be to increase the contrast between these 

colors which will help “pop” and sharpen your image.

	 Step Six: Reclick on the Adjustments tab. This will return you to the Adjustment panel where 

you again click on the Curves icon to open a second Curves adjustment layer. From the second drop 

down menu (which again says Lightness) select “a” which will activate the “a” channel in Lab color 

space. This option allows you to vary the intensity of green and/or magenta (reddish) in your image. 

This is similar to the Tint slider in ACR, but that slider requires that if you increase the green, the 

magenta decreases and visa versa. Again, Lab does not limit you in this manner.

	 Click once more on the small square at the lower left end of the curve (which continues to be a 

straight line) and move it to the right until the Input reads 10. Again, you can do this either by clicking on 

and dragging the square, or by clicking on it and moving it with the right arrow key on your keyboard. 

This will increase the magenta in your image. Now click on the small square at the upper right end of 

the curve and move it to the left until the Input reads 90. This will tone down the effect of the magenta
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because you will have increased the green in your image. As above, the result will be to increase contrast 

which will help “pop” and sharpen your image.

	 Step Seven: Reclick on the Adjustments tab where you again click on the Curves icon to open a 

third Curves adjustment layer. This will be a Lightness adjustment, so there is no need to open the drop 

down menu. However, this adjustment will be to add a slight “s” to the curve. (See the lower screen 

capture to the right.)

	 To do this, click on the middle of the curve so that both Output and Input read 50. If needed, adjust 

these values with the arrow keys (left and right for Input; up and down for Output). Then click on the 

quarter and three quarter points (half way between the 2nd and 3rd squares from both 

endpoints; see the black arrows, top capture, page 93). If done precisely, the Output and Input of the 

quarter point will read 25 while the Output and Input of the three quarter point will read 75. Again, if 

needed, adjust these points using the arrow keys on your keyboard. 

	 Then, using the arrow keys, move the quarter point down until Output reads 22, and move the 

three quarter point up until Output reads 78. Make certain that the quarter point Input remains at 

25, and that the three quarter point Input remains at 75. Again, the result will be an increase in image 

contrast and sharpness. 

	 Your basic Lab processing is now done. However, you do not want to leave your image in Lab color 

space, nor do you want to leave all of your layers active (unless, as discussed later, you want to modify 

one or more of your adjustments). 

	 Step Eight: Merge Visible layers (Ctrl/Cmd Shft E or Layers > Merge Visible), then convert your 

image back to RGB (Image > Mode > RGB Color). 

	 The problem with the above process is that it is time consuming. Fortunately, there is an efficient 

way to deal with this: make it an action. An action is a set of prerecorded steps that Photoshop will 

perform when its “Play selection” button is clicked.
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Greater Prairie Chicken, 
Attwater Prairie Chicken 
NWR, TX. Canon 50D 
camera, Canon 100-
400mm f/4.5-5.6 lens 
@ 330mm, ISO 800, 
f/5.6, 1/640, EC -1/3.

	 Before creating this action, you should create a new actions folder. 

This will make it easier for you to access this action as well as the 

other actions I will discuss shortly. 
	 To do this, click on the “Create new set” button at the bottom of 

the Actions panel (third from the right). This will open a dialog that 

simply asks you to name your new action set (I named mine Mike) and 

click OK. 

	 Then click on the “Create new action” button (second from the 

right). This will open a dialog that asks you to name the action (I named 

mine LAB) and to select the Set in which you wish to place it (i.e.: the 

one you just created). Click “Record” to start recording the recording 

process for an image open in Photoshop. This is similar to recording 

with a tape recorder:

1) Convert to Lab color space,

2) Copy the Background layer layer,

3)Perform Shadows/Highlights adjustment,

4) Perform Curves adjustment: move both ends of channel “b” in 10%,

5) Perform Curves adjustment: move both ends of channel “a” in 10%,

6) Perform a subtle s-curve Curves adjustment (1/4 Output to 22;                                           

    3/4 Output to 78) on channel “Lightness”,

7) Merge visible layers, and 

8) Convert to RGB Color space.

9) Press the “Stop playing/recording” button at the far left of the bottom 

of the Actions panel.
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Ruby-throated Hummingbird, 
Goshen, Cape May County, NJ. 

Canon 7D camera, Canon 600mm, 
f/4.0 lens, ISO 500, f/5.6, 1/640. 

	 Click on the arrowhead to the left of the LAB action you have 

just created to expand it. What you see should be the same as the 

screen capture below (absent the red arrow).
	 The top American Robin image on page 100 is unprocessed. The 

one under it has been processed using our Lab action.

	 I selected this American Robin image for our first example 

because it is mid-toned with no particularly bright or intense 

areas. 

	 This is the type of image that is the easiest to process in Lab. 

This is not to say that there is no more we can, and will, do to it.

Rather, it is to say that there is no 

need to tweak any Lab action 

steps. 

	 However, before we discuss 

tweaking Lab processed images, 

let’s look at two more images that 

also do not need such tweaks.
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	 The Alpine Touch-Me-Not at the top of page 101 is another 

example of a mid-toned image and, as such, is unlikely to need tweaking 

after it is processed using our Lab action. The same is true for the 

young Brown Bear below. Thus, neither will have anything else done 

to them beyond our Lab action at this time.	

	 The top image on page 101 is unprocessed while the bottom one 

has been processed with our Lab action. Note the increased sharpness 

and richness in the flower petals. Likewise, the image below is unprocessed 

while the one on page 103 shows similar processing effects.
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LAB TWEAKS

However, a number of images can be improved if they are tweaked 

(edited) after you process them with our Lab action.

	 Step One: Immediately after processing an image, click on the 

History tab which, if you have been following along, will be in 

the same panel as your Actions tab. Then click on the line below the 

Curves 3 Layer (red arrow, left capture, page 104).

	 Step Two: This will cause your Layers panel to display five 

layers (right capture, page 104). 

	 The bottom layer, Background, is your original image. Layer 1 is 

your Shadows/Highlights adjustment. Curves 1 is your Lab “b” 

blue/yellow adjustment. Curves 2 is your Lab “a” green/magenta 

adjustment. Curves 3 is your Lab Lightness adjustment.

	 While tweaking may be warranted in any layer other than 

Background, the majority will involve the Shadows/Highlights layer. 

The reason for this is that Shadows/Highlights often creates a halo 

around your subject that should be corrected. (I prefer to call it 

ghosting, and will hereinafter). Fortunately, all that is required is to 

click on Layer 1 (highlighted in blue, right capture below) and move 

the Opacity slider (red arrow, right capture below) to the left until 

the ghosting has disappeared. 
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Downy Woodpecker, Goshen, Cape May 
County, NJ. Canon 1D Mark IV camera, 
Canon 600mm f/4.0 lens, Canon 2.0x II 

teleconverter, ISO 1600, f/8.0, 1/200.

GHOSTING

The next two sets of images 

demonstrate ghosting and 

how to deal with it. The first is a 

landscape image of Quoddy Head 

SP in Maine while the second 

is an image of a soaring Turkey 

Vulture.	

	 The first image in this sequence 

(top, page 106) is unprocessed. The 

second image (bottom, page 106) 

was processed using our Lab 

action. If you look closely where 

the sky meets the trees over the 

island in the distance and left of 

the lighthouse in the lower image, 

you will notice that the sky is paler 

than it should be. 	

	 Step One: Click on the third 

from the bottom line in your 

History tab. As noted, this will 

show all five of your adjustment 

layers in your Layers panel. 
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	 Step Two: Click on Layer 1. At the upper right of this panel is the 

Opacity slider (red arrow, right capture, page 104). Click on the word 

“Opacity” and drag with your mouse to the left to eliminate the 

ghosting. There is no set amount for this, so experiment.

	 Step Three: Although you have now removed the ghosting, 

one more step is needed. Click your Actions tab again and click the 

next to the last line in your Lab action (“Merge Visible”, red arrow, 

capture, page 109). Then click the “Play selection” button (the 

triangle) at the bottom of your Actions panel, which will run your 

Lab action but only from that level on.

	 The image above is the result of our three step ghost removal 

which ended with our returning the image to RGB.
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Carolina Saddlebags, Cape May Point SP, 
NJ. Canon 7D camera, Canon 300mm 
f/2.8 lens, Canon 2.0x III teleconverter, 

ISO 500, f/5.6, 1/400. EC +1/3.

Atlantic Bottlenose Dolphin, Delaware 
Bay, Cape May County, NJ. Canon 7D 

camera, Canon 300mm f/2.8 lens,
ISO 200, f/5.0, 1/1250. 

	 The Turkey Vulture sequence 

contains another example of 

ghosting and its correction. 

	 The first image (top, page 

108) is unprocessed; the second 

image (bottom, page 108), was 

processed with our Lab action; 

and the third (top, pages 109-

110) is the image corrected as 

noted above.

GOTTA GET RID 

OF DA BLUES

The Black Bear cub image on 

page 112 was shot on an 

overcast day at an ISO of 1600. 

Overcast conditions and high 

ISOs often cause a blue color 

cast that processing, in any color 

space, invariably makes worse. 

The unprocessed version is on 

page 112 while the Lab processed 

one is on page 113. 

	 Step One: Click on the 

History tab of the processed 

image, and click on the line below 

the Curves 3 layer. 

	 Step Two: Click on the 

Curves 1 layer in the Layers panel, 

select “b” from the “Lightness” 

drop down menu, and move the 

top end of the curve to the right 

until the blue cast is eliminated. 

(In this case, to an Input of 97.)
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Step Three: Although we have now removed the blue color cast, one 

more step is again needed. Click your Actions tab; click the next to the 

last line in your Lab action (“Merge Visible”, red arrow, page 109), 

and then click the “Play selection” button (the triangle) at the bottom 

of your Actions panel. The result is on page 114.

HUE/SATURATION

The image on page 115 was tweaked using Hue/Saturation after it 

was processed with our Lab action. This is not to imply that Hue/

Saturation offers a better correction than the tweaking as we did above; 

rather it is just that one hallmark of digital photography in general 

and Photoshop in particular is that there are multiple ways to do just 

about anything. However, these different approaches can yield different 

results, and you must choose which you prefer.

	 Step One: Click on the left icon in the middle row of  the 

Adjustments panel. This will open the Hue/Saturation dialog. 

	 Step Two: From the second drop down menu (the one that says 

“Master”), select “blues” and slide the Saturation slider to the left until 

the blue color cast has been eliminated. 	

	 Step Three: You have now removed the blue color cast, but 

one more step is needed: merge the layers (Shift Ctrl/Cmd E or 

Layer > Merge Visible). Again, I am not suggesting that one method 

is superior, just that you have a choice.
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	 TOO [RED] HOT

TO HANDLE!

Red has the longest wave length in the realm of visible light. For 

the digital photographer, this means that red is the hardest color 

to process as it often results in a loss of detail with even minor 

adjustments. Further complicating matters is the fact that processing 

in Lab, because of its power, can exaggerate such issues.

	 The unprocessed image of the Northern Cardinal on page 117 

presents a classic red processing example. 

	 The image on page 118 was processed using our Lab action. 

Note that the feathers on its chest and cheek have little to no 

detail. On page 119 is a tweaked version. To get there I did the 

following:

	 Step One: After processing the image in Lab, I clicked the History tab. 

	 Step Two: I then clicked on the line below the Curves 3 Layer. 

	 Step Three: I next clicked the Curves 2 in my Layers pamel. 

	 Step Four: I selected “a” from the “Lightness” drop down menu 

on my Adjustments panel. 

	 Step Five: I clicked on the midpoint of the curve to set an 

anchor point (both Input and Output will read 50). 

	 Step Six: I then moved the bottom end of the curve to 0 and the 

upper end of the curve to 92. 

	 Step Seven: I then merged visible and converted to RGB.
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Great Kiskasee, Bentsen/Rio 
Grande SP, Mission, TX. Canon 
1D Mark IV camera, Canon 
300mm f/2.8 lens, Canon 2.0x 
t e l e c o n verter, ISO 1600, 

f/5.6,  1/3200, EC +1/3.

                             HUE/SATURATION	

The final image in this sequence (page 120) was tweaked after it 

was processed using our Lab action. As with the last Black Bear 

cub image, this was done using a Hue/Saturation Adjustment layer. 

Unlike the bear image, however, where it was fairly obvious 

that reducing blue’s saturation would remove the color cast, the 

approach to regaining the detail in this Northern Cardinal is less 

obvious. 

	 Step One: I Clicked on the Hue/Saturation icon (left icon, 

middle row of the Adjustments panel), and select “Reds” from the 

“Master” drop down menu. (So far, this should not be much of a 

surprise.)

	 Step Two: I then increased (moved to the right) the Saturation 

slider to +20. (This made the lack of detail in the red even worse!)

	 Step Three:  I next decreased (moved to the left) the 

Lightness slider to -15. 

	 Step Four: Finally, I merged the layers (Shift Ctrl/Cmd E or 

Layer > Merge Visible).

	 If I had not first increased the saturation in the reds channel, 

reducing its lightness would have made the image flat and lifeless. 	

	 As with many aspects of digital photography, some things are 

obvious while others are not. Also, note that the results are different, 

so you must choose the one you prefer.
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         In the next 4 images the subject is not the problem; rather, 

it is the flower. The top image on page 124 is unprocessed; the 

bottom one was processed using our Lab action; the top image on 

page 125 was tweaked in Lab as follows:

	 Step One: I clicked the History tab and I then clicked the line 

below the Curves 3 Layer in my History panel. 

	 Step Two: I clicked on the Curves 2 Layer in my Layers panel. 

	 Step Three: I selected “a” (the green/magenta continuum) from the 

“Lightness” drop down menu from my Adjustments panel. 

	 Step Four: I then clicked the midpoint of the curve to set 

an anchor point (again, both Input and Output will read 50).

	 Step Five: I moved the bottom end of the curve to 0 and the 

upper end of the curve to 95.

	 Step Six: Finally, I merged the layers (Shift Ctrl/Cmd E or 

Layer > Merge Visible).

	 The image at the bottom of page 125 was tweaked using a 

Hue/Saturation adjustment thusly: 

	 Step One: I selected “Red” from the “Master” menu in my 

Hue/Saturation adjustment panel. 

	 Step Two: I increased (moved to the right) the Saturation slider 

to +10. This again made the lack of detail in the red worse. 

	 Step Three: I decreased (moved to the left) the Lightness 

slider to -15. Once again, the result was to restore the missing red 

detail.
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Least Tern, Cape May Point SP, Cape May County, NJ. Canon 1D Mark IV camera, 
Canon 600mm f/4.0 lens, Canon 2.0x III teleconverter, ISO 500, f/11, 1/1250.

   	 Step Four: Finally, I merged the layers (Shift Ctrl/Cmd E or 

Layer > Merge Visible).
	 Note that I have made no reference to tweaking images 

with significant green areas. The reason for this is that green is 

in the middle of the visible light spectrum (red is at one ext reme ; 

blue is at the other). As a result, green rarely presents a processing 

problem.
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Lincoln’s Sparrow, Santa Cruz Ranch, Starr Cty, TX. Canon 40D 
camera, Canon 600mm f/4.0 lens, ISO 800, f/5.0, 1/250, EC +1.

ENHANCE

Once you have processed your images with our Lab action, you 

have two additional processing options: Enhance and Enhance 

Warm. As I did when explaining the above processes, I will first discuss 

the steps involved in applying these techniques. I will then explain 

how to convert them into an action.

	 Step One: With your Lab processed image open in Photoshop, 

click on the Selective Color option of your Adjustments panel 

(second icon from the right end in the third row). 

	 Step Two: In the second drop down menu (its default is 

“Reds”), select “Blacks” (the bottom option), and increase the Black 

slider to 10. 

	 Step Three: Select “Neutrals” from the same menu and increase 

the Black slider to 10.

	 Step Four: Finally, merge the layers (Shift Ctrl/Cmd E or Layer 

> Merge Visible).

	 You have now enhanced your image. However, neither this process, 

nor the next one, is appropriate for all images. Likewise, when 

appropriate, you may wish to adjust its opacity.

	 Converting this process into an action involves naming 

it  and recording the steps using the process we used to create 

our Lab action (page 98). In other words, after naming your action, 

perform the following steps:
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1) Click on the Selective Color option of your Adjustments panel;

2) In the second drop down menu (its default is “Reds”), select 

“Blacks” (the bottom option), and increase the Black slider to 10; 

3) Select “Neutrals” from the same drop down menu and again 

increase the Black slider to 10; and

4) Merge your visible layers (Shift Ctrl/Cmd E), and then 

press the “Stop playing/recording” button at the far left of the bottom 

of the Actions panel.

	 Now let’s look at a few examples.

	 The Amer ican Robin image, at the top of the facing 

page, is the same processed image as the one on the lower 

half of page 100. The bottom image on the facing page, however, 

has been enhanced using the steps described above. Notice that the 

increase in contrast helps “pop” and sharpen the image.

	 The Northern Cardinal on page 131 is the same as the 

one on page 119. The one on page 132 has had our Enhance action 

applied to it. Likewise, the Great Spangled Fritillary atop page 

133 is the same as the processed one atop page 125. However, 

the one at the bottom of page 133 has had a slightly different usage 

of our Enhance action applied to it. 

	 Specifically, I applied our Enhance action twice, and then 

backed off the second application by reducing the opacity of its 

layer to 80%. Again, it is up to you to decide which version 

of each pair you prefer.
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Seaside Sparrow, Belleplain SF, Cape May County, NJ. Canon 1D Mark IV camera, 
Canon 600mm f/4.0 lens, Canon 2.0x II teleconverter, ISO 500, f/11, 1/160.

	 Reducing opacity is easy. Each  t ime  you  enhance an 

image, a new layer is formed. Since I enhanced it twice, it added 

two layers, each with its own opacity function. As a result, I was 

able to reduce the second enhancement’s intensity (in this case 

to 80%). To do this, press “8” immediately after enhancing the 

image. Just be certain no brush tool is active, or the size of that tool 

will be changed rather than the image’s opacity! You can also click 

on the word “Opacity” and drag to the left until the desired effect is 

achieved. Either way works.
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ENHANCE WARM

Some images, especially those shot on overcast days, can benefit from 

warming. With film, warming filters were often used to do this. With 

digital, this is unnecessary. Although Photoshop has a photo filter 

adjustment, I find that the Selective Color adjustment does a better job.

	 The image below is processed and enhanced; the one at the top of 

page 136 is processed and enhance warmed; and the one below 

that is processed and combines both enhancements.

	 Recall that our Enhance action involved making two Selective 

color adjustments. The Enhance Warm action simply adds a third 

such adjustment:
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Dunlin, Heislerville WMA, Cumberland County, NJ. Canon 1D Mark IV camera, 
Canon 600mm f/4.0 lens, Canon 2.0x III teleconverter, ISO 500, 1/250, f/11.

	 Step One: Click on the Selective Color option of your Adjustments 

panel (second icon from the right end in the third row). 

	 Step Two: In the second drop down (it says “Reds”), select 

“Blacks” (bottom option), and increase the Black slider to 10. 

	 Step Three: Select “Neutrals” from the same drop down 

menu and again increase the Black slider to 10.

	 Step Four: Select “Whites” from the same drop down menu 

and increase the Yellow slider to 10. Finally, merge your visible 

layers (Shift Ctrl/Cmd E).

	 To convert this process into an action involves naming it  and 

recording the above noted steps (as we did with our LAB action 

- see page 98): 

	 After naming the action:

1) Click on the Selective Color option of your Adjustments panel;

2) In the second drop down menu (“Reds”), select “Blacks” (the 

bottom option), and increase the Black slider to 10;

3) Select “Neutrals” from the same drop down menu and again 

increase the Black slider to 10; and

4) Select “White” from the same drop down menu and increase the 

Yellow slider to 10.

5) The final step is to press the “Stop playing/recording” button at 

the far left of the bottom of the Actions panel. 

	 Note that you can combine both enhancement actions in any 

number of combinations with any number of opacity settings. 
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Lesser Prairie Chicken, Buffalo, OK. Canon 50D camera, Canon 500mm 
f/4.0 lens, ISO 400, f/8.0, 1/1000, EC -1/3.

SHARPENING

We all know when an image is sharp, right? It’s in focus, right? 

The problem is that few people seem to know what these 

concepts mean, especially when it comes to processing digital images.

	 An image is sharp when there is a significant degree of contrast 

between adjacent pixels. The greater this contrast, the greater the 

sharpness. As a result, all of the many techniques and programs for 

sharpening digital images lighten some pixels, typically those along 

edges within an image, and darken those next to the lightened ones.

	 There are three general points to note when it comes to 

sharpening. First, no amount of sharpening will cause an 

out of focus image to become in focus. Second, it is easy to over 

sharpen an image which will cause it to look unnatural. Third, the 

later in your processing workflow that you sharpen, the better. Were 

you to sharpen early on, any sharpening artifacts (pixels that do not 

appear natural) will be exaggerated.

	 One of the realities of digital capture is that the image will 

always be softer than the original subject, which means that all 

digital images should be sharpened. However, our Lab action 

involves steepening the curves in all three Lab channels. The effect 

of steepening a curve is that it increases contrast which also increases 

image sharpness. As a result, I do not sharpen my images as much as 

I did before I started processing in Lab color space. 



141 142

	 Having said that, when I do sharpen my images, it is usually just 

around the eyes as that is where the focus is in most wildlife imagery.

	 The White-crowned Sparrow on the facing page was processed 

via our Lab and Enhance actions. To create the image on page 143, 

I sharpened the eye using the following process: 

	 Step One: Duplicate the layer of the processed image(Ctrl/

Cmd J). 

	 Step Two: Go to Filter > Sharpen > Unsharp Mask. Set the 

Amount to 300, and the Radius and Threshold to 1, and click OK. 

This will sharpen the entire image, and almost certainly 

do so excessively. 	

	 Step Three: Click on the “Add a mask” icon at the bottom of 

the Layers panel (3rd from left). 

	 Step Four: With white as your foreground color (press “D” if it is 

not), press Ctrl/Cmd Delete/Backspace to fill the layer mask with black. 

This will hide (block) the sharpening you have done to this layer. 

	 Step Five: Activate your brush tool (press “B”). Use the bracket 

keys (“[“ to reduce its size; “]” to enlarge it) to match the size of 

the bird’s eye. With the mask active (click on it), paint over the 

bird’s eye. This may result in the eye being over sharpened.

	 Step Six: If needed, reduce the sharpening effect by decreasing 

this layer’s Opacity.

	 Step Seven: Press Ctrl/Cmd E to merge the visible layers, and 

save your image. 
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THE FINAL STEP: 

16 BITS TO 8 BITS/CHANNEL

Photoshop allows you to process your images in either 16 or 8 

bits per channel. Once you have finished processing your 

images (which, if you have been following my procedure, you 

have done in 16 bits per channel), you should convert them to 8 

bits per channel as this will reduce the size of your files by 50%. 

	 This is a simple, two step process, but it will be easier to apply 

if you make it an action:

	 Step One: Go to Image > Mode.

	 Step Two: Check 8 Bits/channel.

	 At the risk of being redundant, here’s how to create an action 

encompassing these steps: 

1) Press “Create new action” (2nd from right, bottom of the Actions 

panel) and name this action, 

2) Go to Image > Mode and check 8 Bits/channel, and

3) Press the “Stop playing/recording” button (far left of the bottom 

of the Actions panel).

	 You have now processed your RAW images. This is not to say 

that there is not more you can do, but you now have the basics. Just 

don’t forget to save your images and move them to your File subfolder.

	 Starting on page 145, I explain the “why” behind the how. 

It’s up to you whether or not to read it now, later, or at all.
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Black-throated Sparrow, Santa 
Cruz Ranch, Starr County, TX. Canon 
40D camera, Canon 600mm f/4.0 lens, 

ISO 400, f/16, 1/125, EC -1/3.

Why-Do-It-This-Way

THE HISTOGRAM

One of the most useful tools in digital photography is the 

Histogram, yet many people seem to not understand its 

purpose or the information it provides.

	 Simply stated, a histogram is analogous to a bar chart, also 

called a bar graph, in which the adjacent bars touch. A simple example 

starts with the bar chart of the days of the months vs the months

of the year at the bottom of these 

two pages. As you can see, each 

column of this bar chart represents a 

different month of the year while 

each row represents a different 

day of each month. 

	 The only way this differs 

from a histogram in form is that 

the bars do not touch.
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	 The graph below is in histogram form since its bars touch. In a photo histogram, the bottom line is tonality (brightness) with pure white 

with no detail at the right end, and pure black with no detail at the left end. Some photo histograms are displayed in black and white while 

others are displayed in color. Some color versions show the 3 primaries on individual graphs while others combine them. 	
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 	 The histograms on page 150 include a black and white version at 

the top followed by three single color versions below: red, green, 

and blue. The histogram on page 151 is a multi-color version that 

shows all three primaries on one graph.

	 (As an aside, we all know that there are three primary colors, right? 

However, they are: red, green, blue, and yellow. SAY WHAT!?! 

This is not a misstatement; rather, there are two sets of primaries, 

each of which contains three. You may remember your school art classes 

where you mixed equal amounts of blue and yellow to get green. 

That works because the three primaries of pigment are red, blue, and 

yellow (RBY). On the other hand, photography records light, not pigment, 

and the three primaries of light are red, green, and blue (RGB). Hence, 

there are three primaries; it’s just that there are four of them!)

	 These histograms are of the American Robin we processed 

(see page 151). As noted, the left end is black without detail, and is 

assigned a value of 0. The right end is white without detail, and is assigned a 

value of 255. This represents 256 variations of black to white called

tones, and covers 5-6 stops. (A stop is a halving or doubling of light.)

	 We can divide the histogram into five equal parts along its bottom 

edge, the far left area can be called very dark, the next can be called dark, 

the middle Medium (i.e.: 18% gray, what reflective light meters strive to 

produce), the second from the right light, and the far right very light. 

	 A scene of more than 5-6 stops cannot be fully recorded, in a single 

image, as your camera can not handle more than 5-6 stops per exposure.

 	 The vertical part of a histogram 

displays the number of pixels 

at each tonal value. (Pixels is an 

abbreviation of “picture elements” 

which are the squares that make 

up your image and which can be 

seen if  an image is overly 

enlarged. Each pixel is assigned

three values, one each for red, 

green, and blue.) 

	 The top histogram on this 

page shows that most pixels in our 

Robin image are mid-toned to a 

bit brighter than mid-toned, many 

are mid-toned to dark, some are 

very dark; and others very light. 

What is important is that none run 

up either side of the histogram.

	 The single color histograms on 

this page show the distribution of 

pixels in each channel of the image. 

As in many images, red is more to 

the right (brighter) than green which 

is more to the right than blue.
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	 The multi-color histogram at the top of this page combines the 

single color histograms of page 150. The white areas represent the pixels 

that contain all three primary colors. The yellow areas represent the 

red and green pixels. The cyan (light blue) areas represent green and 

blue pixels. The magenta (rose) areas represents the red and blue pixels. 

Red represents red; green represents green; blue represents blue.

	 All well and good, you may be saying, but what does this have 

to do with processing my images or, for that matter, shooting them 

in the first place? The simple answer is “just about everything!” 

A histogram represents all of the data your camera recorded. Thus, if 

a line runs up either side of your histogram, your image does not 

contain all of the data in the scene you photographed. If a line runs 

up the left side, your image has areas of black with no detail. If a line 

runs up the right side, your image has areas of white with no detail. 

Obviously, if lines run up both sides, you have lost detail in both 

areas. 

	 While there are times that areas of no detail are not a problem, 

such as the highlights from a car’s well polished bumper, they are 

the exception, not the rule. Generally, you want detail in all parts of 

your images, especially the lighter areas. Also, the wider your histogram, 

the more contrast your image will have, and this is usually (but not 

always) desirable as it also inceases sharpness. 

	 Your next question, and about the most common one I hear 

concerning histograms, may be “what makes a good histogram?” 

Unfortunately, there is no particular pattern that constitutes a good 

histogram as each depends upon its image. 

	 For example, the swan histograms (page 154) look nothing like 

our Robin histograms (page 150), but both are fine given their 

respective images because the robin picture has many more tones 

than does the swan image.



Mute Swan, Cape May Point SP, 
NJ. Canon 7D camera, Canon 100-
400mm f/4.5-5.6 lens @ 400mm, 

ISO 500, f/11, 1/1250. 
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	 There is, however, such a 

thing as a bad histogram, and the 

ones on this page are examples. 

They are from the Red-spotted 

Purple image at the top of pages 

155 & 156, and which we looked 

at in the Introduction. 

	 As I then noted, this image 

was over exposed by 1 2/3 stops. 

As a result, both the red and 

green channels are blown out. 

In the realm of light colors, red 

and green combined yield yellow, 

so these histograms are telling 

us that the yellows in this image 

(i.e.: the reds and greens) have 

lost significant detail.

	 Also note that the blue 

channel is blocked. This, however, 

is not a big deal in this image 

as the blocked areas are the 

background spaces between the 

flowers and, as such, are not 

significant parts of this image.	

	 What allowed this image to be 

saved is the fact that not all of the 

channels were blown out. 

	 This is shown by the fact 

that the bottom histogram (the 

blue channel) does not have a line 

running up its right side. It is also 

shown by the top histogram (the 

multi-color one) not having white 

running up its right side. The 

significance of this is that there 

are data present that can be used 

to salvage the image in ACR.

	 Having said that, the amount 

of detail from 243-255 on your 

histogram (i.e.: the brightest 5% of 

the data your camera can capture) 
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is very hard for the human eye to appreciate. As a result, it is generally best (absent an intent to blow out 

certain areas of your image) to not approach the right side of your histogram closer than 242. However, 

it is often a good idea to have data at the brightest end (again, up to but not beyond 242) of each channel 

in your histogram. The exception is when your image has a limited range of tones.

	 As discussed in the next section, the issue is a bit different at the dark end of the histogram. There 

is less data at the dark end (by a lot!), and your subject is more likely to be bright than dark.

EXPOSE [TO THE] RIGHT, 

PARDNA
	

Today’s cameras can record 

5-6 stops of light. For the 

sake of simplicity, we’ll round 

this off to 6 stops. 

	 Many believe that an 18 

megapixel camera, such as the 

Canon 7D, captures 3 megapixels 

per stop (3 x 6 = 18). However, 

pixel distribution is not linear; 

rather, the brightest stop contains 

1/2 of the pixels, the second 

brightest contains 1/4 of them, 

the third brightest contains 1/8, 

the fourth contains 1/16, the fifth 

contains 1/32, and the darkest stop 

contains only 1/64 of the image’s 

pixels!

	 In other words, with the Canon 

7D, the first stop on the right 

(the brightest) contains 9 of the 

camera’s 18 megapixels, the
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Cooper’s Hawk. Cape May Point 
SP, Cape May County, NJ. Canon 
1D Mark IV camera, Canon 300mm 

f/2.8 lens, ISO 500, f/4.0, 
1/3200, EC +2/3.

second contains 4 1/2 megapixels, the third contains 2 1/4, the 

fourth contains 1 1/8, the fifth contains 9/16, and the darkest stop 

contains a mere 9/32 of a megapixel (out of 18 megapixels)! 

	 This does NOT mean that if you capture an image that has no 

data in the two brightest stops, the result will be a 4 1/2 megapixel 

image. But what it DOES mean is that the quality of the image may 

be no better than one taken by a 4 1/2 megapixel camera. 	

	 True, image brightness/exposure can be adjusted in Photoshop, 

but there is a significant downside: digital noise. (There are two 

types of digital noise: color and luminance. Color noise is the presence 

of random pixels of inappropriate color. Luminance noise is the 

presence of random pixels of inappropriate brightness or darkness.) 

	 The vast majority of digital noise occurs in the darker areas of 

images. As a result, when you brighten an image in Photoshop (or 

any  o ther  image processing software), you are moving the darker 

areas to the right where they will occupy a greater percentage of 

the image’s pixels. This, in turn, will accentuate the noise in the 

image which often degrades its quality. (A classic example of color 

noise is on pages 159-160.)

	 The solution is to expose to the right. 

	 This means that, for an image with a reasonably wide 

range of tones, you will have more high quality information 

to work with if your histogram contains data well into the 

brightest stop (i.e.: as close to 242 as you can). 



159

Left to Right: Jeff Bouton, Kevin Karlson, Bob Behrstock, Mike Hannisian, Rio Grande Valley Birding Festival, Harligen, Cameron County, TX. Canon PowerShot G9 camera, 7.4-44.4mm lens 
@ 7.4mm, ISO 400, f/5.0, 1/60, by Nancy J Watson. (Note: the excessive noise in this image is the result of over processing done for demonstration purposes.)

160
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CONTRAST:

WHAT IS IT, AND 

WHAT DOES IT DO?

Contrast is the measure of the tonal difference between adjacent 

pixels. (Now, isn’t that informative!)

	 The significance of contrast is that it adds “pop” or “snap” to 

images, and is the main reason we discussed enhancing them (with or 

without warming). Contrast also helps sharpen images. True, some 

images do not do well with increased contrast, but many do. 

	 We previously worked on the two American Robin images (page 

161). The top is our original version while the bottom is our processed 

and enhanced version. Notice that the bottom image has more detail 

than the top one, especially on the bird’s breast, belly, and face.

	 One of the reasons that these parts of the bottom bird appear 

snappier is that the colors do not blend into each other to the extent 

that they do in the top bird. If you understand contrast, this is not 

a surprise as (again) contrast is the measure of the tonal difference 

between adjacent pixels. 

	 Contrast is, perhaps, most significant in images that have 

very dark or very bright subjects such as the Black Bear cub and the 

Mute Swan images on page 163. Notice that in the left Black Bear 

cub image there is little detail in the fur between the eyes and on its 

upper chest. Then compare these areas with the same ones on the



Black-tailed Prairie Dog, Canon 1D Mark II camera, Canon 500mm 
f/4.0 lens, Canon 2.0x II teleconverter, ISO 400, f/8.0, 1/1600, EC -1/3.
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cub to the right. Similarly, there is more detail in the tree bark in the 

right image than in the left one. In both cases, the increased detail 

was achieved by increasing contrast.
	 The Mute Swan image presents a different situation and a 

different challenge. Again, light meters want to make all images 

mid-toned. As a result, I added 2/3 of a stop of light to the meter’s 

suggested exposure. This kept the whites white without blowing 

them out. In other words, my original image had good detail in the 

brightest area of its histogram. Thus, when Shadows/Highlights was 

applied, this detail was made all the more visible. The rest of our Lab 

processing action and our enhance warm action increased this effect.
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Cattail punk, Conners Lake, 
Anchorage, AK. Canon 1D Mark 
IV camera, Canon 500mm f/4.0 

lens, Canon 2.0x III 
teleconverter, ISO 800, 

f/8.0, 1/500.

SCRATCH THAT DISK

As I noted earlier, when setting up Photoshop you are asked to 

identify a scratch disk. Unfortunately, if you do not already know 

what a scratch disk is, Photoshop does not help you figure it out.

	 As with many things unknown, the concept of a scratch disk 

is not difficult, you just need someone to tell you what it means. 

A scratch disk is a computer drive that, in this case, Photoshop 

can turn to when all of your RAM is being used.

	 The problem is that not all of us are equally knowledgeable 

about how computers perform their magic. Suffice it to say that you 

can think of your computer as a file cabinet holding all of your 

information in the form of digital files. Remember, a digital image 

is a file containing a set of three numbers for every pixel - one each 

for its RGB (red, blue, and green) values. Likewise, you can think of 

your desktop as holding the files you expect to work on, and your 

RAM as holding the files you currently are working on.

	 Were you to open so many files that your RAM became full, 

your computer would need another location to put data. This is 

a scratch disk. If you have only one hard drive, that is the only place 

your computer can use, hence there is no other place to designate as 

your scratch disk. However, if your computer has more than one 

drive, the proper choice for your scratch disk is a drive on which 

Photoshop is NOT installed.
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Hatcher Pass, Talkeetna Mountains, AK. Canon 7D camera, Canon 
28-135mm f/3.5-5.6 @ 28mm, ISO 500, f/16, 1/125.

	 The problem with locating your scratch disk on the same drive 

as Photoshop is that this will slow down your computer when your 

RAM fills up as you will be asking one drive to perform multiple, 

simultaneous actions. However, if you have designated a different 

drive as your scratch disk, this will not slow down your computer as 

much since you will not be asking one drive to do the work of two.

	 All well and good, but today’s reality is that both computers 

and RAM are constantly becoming larger and faster as they become 

less expensive. As a result, where you designate your scratch drive is 

not as important as it was a few short years ago.

LAB: HELL’S OWN COLOR SPACE

Most of us are familiar with two color spaces, RBY and RGB. 

RBY is the color space we learned in our school art classes. Its 

name comes from the three primary colors of pigment: red, 

blue, and yellow. Mix equal amounts of red and yellow to create 

orange, equal amounts of blue and yellow to create green, etc. RGB, 

on the other hand, is the color space of light. Its name comes from 

the three primary colors of light: red, green, and blue. If you remove 

all of the blue from pure white light, the result is yellow; if you 

remove all of the red from pure white light, the result is cyan; etc.

	 Lab, however, is a totally different structure. Its name is derived 

from the fact that it is composed of three channels: Lightness, “a”, and 

“b”. Lightness represents an image’s tonal values and, as such, is 

a black and white representation of the image, albeit usually 

a rather flat one. Channel “a” represents the green/magenta continuum 

while Channel “b” represents the blue/yellow continuum.

	 The image at the top of page 170 is a processed, enhanced photo 

of some nice Autumn foliage in the mountains of western North 

Carolina in the RGB color space. The image below it is the Lab version 

of the same image limited to the Lightness channel. As you can see, it 

is essentially a monochromatic version of the original. (Because the 

original is a high contrast image, the Lightness version is not as flat 

looking as is often the case in this color space.)
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Tricolored Heron, Alligator Farm, St Augustine, FL. Canon 1D Mark IV camera, 
Canon 300mm f/2.8 lens, Canon 2.0x III teleconverter, ISO 1000, f/8.0, 1/100.

	 The two images on page 171 are the Channel “a” (top) and 

Channel “b” (bottom) versions of the original. If you find these 

versions less than lucid, join the club! Note that the foreground tree 

in the original image, and the little one to its left, are reddish 

(magenta like). In the lower left foreground of the original frame is 

a bright orange tree. Now look at the Channel “a” (green/magenta) 

version at the top of page 171. These trees are amongst the brightest 

objects in this image. This means they contain significant amounts 

of magenta. In other words, the brighter an object in Channel “a”, 

the more magenta (red) it contains. Likewise, the dark green tree to 

the right of the big red tree is very dark in the Channel “a” image. 

Thus, when Channel “a” is dark, it contains a lot of green.
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	 The brightest area in the lower (Channel “b”) image on page 171 is 

the sunlit grass region. Channel “b” is the blue/yellow continuum. While 

grass is typically green, it also contains a significant amount of yellow. 

What this tells us is that the brighter an object in Channel “b”, the more 

yellow it contains. Likewise, the upper left corner is blue sky, and it is 

rather dark in this channel view. As such, this tells us that the darker an 

object is in Channel “b”, the more blue it contains.

	 Two final thoughts. First, the image on this page combines Channels 

“a” and “b”. Thus, it reflects the brightest and darkest areas of both 

Channels. Second, Lab tends to work best on images without bright 

colors. However, I used this highly colored image because its channel 

versions better demonstrate the points I want to make.
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SO WHY IS CURVES STRAIGHT?

Curves is arguably the single most powerful image editing tool in existence. In fact, some very 

skilled practitioners claim that they make all of their image adjustments with this tool. 

	 So why is Curves not used by everyone?

	 The initial answer is that Curves is a bear! But there is more to it than that. Each new iteration 

of Photoshop provides new tools and/or new refinements to existing tools that are more user friendly 

and can accomplish many of the same effects traditionally done in Curves, but with less effort.

	 Another factor that causes confusion is that when you open Curves, it is a straight line. The name 

comes from the fact that you can curve this line, and that is where its power comes from. (If you want to 

see just how quickly Curves can radically alter an image, move the bottom left end of the curve to the top 

left and move the top right end of the curve to the bottom right. See the facing Black Vulture images.)

	 However, all you need to know about Curves for our purposes is that the steeper the curve, the 

greater the contrast and, hence, the greater the sharpness in your image. 	

	 This is why our Lab processing structure is largely based upon increasing the steepness of 

the curves of the two color channels, “a” (the green/magenta continuum) and “b” (the blue/

yellow continuum), as this steepening increases the contrast, and hence the sharpness, of the images 

to which it is applied.

	 The Blue Jay image at the top of page 175 is an unprocessed version. As a result, it is rather flat 

with little detail in the bird’s plumage. This is especially notable in its cheek and breast.

	 The bottom image on page 175 has been processed through the step that steepens the curve in Channel 

“b”. Notice that the contrast has been increased and that the bird’s plumage is better defined (i.e.: 

sharper). The top image on page 176 has been processed through the steepening of the curve in Channel 

“a”. Again, note the increase in contrast and sharpness.
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Royal Tern, South Padre Island, Cameron County, TX. Canon 1D Mark 
III camera, Canon 500mm f/4.0 lens, Canon 2.0X II teleconverter 

ISO 800, f/16, 1/1000, EC -1/3.
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SHADE THOSE HIGHLIGHTS

One of the more useful Photoshop functions to come along in 

the last few iterations is the Shadows/Highlights tool.	

	 As previously discussed, many images are improved by increasing 

contrast. One of the easiest ways to do this is via Shadows/Highlights. 

When you first open this tool, all you will see is two sliders: one for the 

amount you wish to adjust your image’s shadows and the other for the 

amount you wish to adjust your image’s highlights. The former has a 

default setting of 50% while the latter has a default setting of 0%. 

	 The image below is an unprocessed original. The one on the top of 

page 178 has had the default Shadows/Highlights adjustment applied.
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Sharp-shinned Hawk, Higbee Beach, Cape May County, NJ. Canon 1D Mark 
IV camera, Canon 500mm f/4.0 lens, ISO 1600, f/4.0, 1/8000, EC +1 2/3.

Dingy Purplewing, Parque National 
Los Marmoles, Hildago, MX. Minolta

Diamge 7i camera, 7.2-50.8mm 
f/2.8-3.5 lens @ 50.1mm, 

ISO 100, f/3.4, 1/180.

	 The lower image on page 178, however, has had a Shadows/

Highlights adjustment with the settings I recommended earlier: 

both Shadows and Highlights amounts set to 25%. (Recall that I 

made other suggestions concerning the setup of Shadows/Highlights, 

starting on page 91, including checking the Show More Options 

box.)

	 To my eye, the Shadows/Highlights default settings tend to wash 

out the image. True, my suggested settings can be too severe as well, 

but the Lab action I laid out provides you the opportunity to return 

to the Shadows/Highlights layer so you can adjust it. 

	 Regardless, Shadows/Highlights is a very useful tool for adding 

contrast and, in a number of cases, saving images that at first may 

appear to be beyond help.

16 VS 8 BITS PER CHANNEL

In the space of about a decade, digital capture has gone from a 

modestly interesting curiosity to the predominant form of amateur 

and professional photography. Underlying this overwhelming 

acceptance of digital is the fact that its quality has increased 

greatly. For example, I bought my first digital camera in July 2002. 

It was a 5.25 megapixel Minolta Dimage 7i that produced images of 

about 15 MB. (My current equipment produces images of 102 

MB, while today’s newer cameras produce images of 120 MB or 

more!) However, if properly shot and processed, the images from 

the 7i are quite good as shown by the Dingy Purplewing image 

below.
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Upper image: Montezuma Cattleheart, Xilita, San Luis Potosi, MX. Minolta 
Diamge 7i camera, 7.2-50.8mm f/2.8-3.5 lens @ 50.1 mm, ISO 100, f/3.4, 1/180.

Lower image: Cooper’s Hawk, Cape May Point SP, NJ. Canon 1D Mark 
IV camera, Canon 300mm f/2.8 lens, ISO 400, f/2.8, 1/8000, EC +1.

	 Current digital cameras are typically capable of producing images 

containing 14 bits per channel. Photoshop generally views these as images 

of 16 bits per channel, but 2 bits are reserved for metadata. Great, but 

what does this mean?

	 Historically, images were created at 8 bits per channel. This resulted 

in potentially 256 tonal variations per color channel (red, green, and 

blue) or a total of approximately 17,000,000 tonal variations per 

pixel. Sounds like a lot, doesn’t it? However, at 14 bits per channel, 

the potential is 16,386 tonal variations per color channel (red, green, 

and blue) or a total of approximately 4,400,000,000,000 tonal variations 

per pixel.

	 The top image on the facing page is another shot with the 5.25 

megapixel Minolta Dimage 7i, while the one below it was shot with 

a 15.1 megapixel Canon 1D Mark IV. The upper image (Montezuma 

Cattleheart) can be printed quite nicely at 11 x 14 inches. The bottom 

image (Cooper’s Hawk), on the other hand, can be printed quite 

nicely at 3 x 4.5 feet. This is a significant difference, but what does 

this have to do with processing your images? The answer is that the 

more data you have to work with, the more processing you can do 

without producing noise or other artifacts. Likewise, the more data 

you have, the larger a quality image you can print. 
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Left: Crested Caracara, Santa Cruz Ranch, Starr County, TX. Canon 1D Mark 
III camera, Canon 500mm f/4.0 lens, ISO 400, f/5.6, 1/2000, EC -1/3.

	 However, once you have processed your images at 16 bits per 

channel, you will have a group of very large files that you will have 

to deal with in order for you to be able to file, store, and locate them 

in the future. (These issues will be dealt with in detail in Part 3.) At 

this point, suffice it to say that once your images have been 

processed, there is no advantage to keeping them in 16 bits per 

channel as this will double the size of each image you will need to 

file and store. As a result, I suggest that you reduce your processed 

images to 8 bits per channel (Image > Mode > 8 Bits/Channel).

	 The one exception to this is if you are working on an image that 

you are likely to have to reprocess. True, you can always go back to 

your RAW file and start over, but if you have a good reason to 

believe you may need to reprocess a particular file, than you should 

leave it in 16 bits per channel.

LAYERS AND LAYER MASKS

Layers is one of the most useful concepts in Photoshop, or 

any other image processing software. Think of your image 

as your background layer. You can then place a piece of clear 

plastic over it, and paint on the plastic. You can repeat this process 

as often as you like by adding more layers (more sheets of plastic). 

You can also rearrange the order of your layers, keeping in mind 

that what you have painted on a layer covers all that is below it.

	 There are, however, two significant difference between layers 

and the above description. First, when you do something on a layer, 

it affects everything on that layer. In other words, if you sharpen a 

layer, the sharpening effect will be applied to your entire layer even 

if all you wanted to do is apply it to part of your image.

	 This is where layer masks come into play. A layer mask appears 

as a white rectangle in your layer panel. Layers created via the Adjustments 

panel come with layer masks. You also can add a mask to any layer 

by clicking the “Add a mask” button at the bottom of the Layers panel 

(3rd icon from the left). Adding a layer mask activates the mask. 

Active layer masks are told by the double lines around the mask icon 

(red arrow; top of page 185). You can deactivate the layer mask (green 

arrow; top of page 185) by clicking on the image icon on your layers 

panel, and reactivate it by clicking on the layer mask icon.
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Purple Martin, Cape May Point SP, NJ. Canon 7D camera, Canon 
300mm f/2.8 lens, ISO 500, f/5.6, 1/1600, EC +1 2/3. 

Eastern Kingbird, Avon, Livingston County, NY. Canon 50D camera, Canon 
600mm f/4.0 lens, Canon 1.4x II teleconverter, ISO 800, f/6.3, 1/320, EC -1/3.

	 Layer masks allow you to paint on the image in black to block 

the effect created on that layer. If you painted (filled) the entire 

layer mask with black, it would be as if you had done nothing to that 

layer. I often do this and then paint in white to apply the effect to a 

limited area.

	 Second, you can fade the opacity of a layer by dragging the 

Opacity slider to the left. If you move it all the way to the left, it will 

undo everything on that layer. To do this, click on the word “Opacity” 

and drag to the left until the desired effect is achieved. (Left of 

“Opacity” on your Layers panel is the Blending Modes drop down 

menu. This is a powerful tool, but is beyond the scope of this work.)
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Right: Cooper’s Hawk, Santa Cruz Ranch, Starr County, TX. Canon 1D 
Mark III camera, Canon 600mm f/4.0 lens, Canon 1.4x II teleconverter, 

ISO 400, f/5.6, 1/500, EC -1/3.

PART 3: 

ORGANIZING AND STORING YOUR IMAGES

If you have been following the steps I laid out in Parts 1 & 2, you 

now have a group of edited, named, and processed images. In 

Part 1, I also advised you to create a New Images folder with four 

subfolders: Edited, File, New, and Process. My suggested approach 

is to download your images into your New subfolder. Edit and then 

move them to the Edited subfolder. Next, name your images and 

move them to your Process subfolder. Process your images and move 

them into your File subfolder. 

	 However, if you do not next organize and store your images, all 

of your efforts may be for naught as it will become increasingly 

difficult for you to find and otherwise access your work in a 

reasonable, efficient manner. 

	 The easiest way to structure your image folders to avoid 

such problems will, of course, depend upon the type of shooting you 

do. As noted earlier, I am primarily a wildlife/nature photographer. 

As such, my structure is based upon the species for my animal 

and plant images and location for my landscape/scenic images. 

This approach is illustrated by the screen captures on page 190. 
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                        		      ORGANIZING	

As noted, you should have three iterations of each of your images: 

one is the RAW file as it came out of your camera (except for the 

new name you gave it), another is the DNG version, and the third is 

the processed version. All of these now should be in your File subfolder.

	 Your next step is to create three new folders: CR2 (if you shoot 

Canon, if not you can use the name of the RAW format used by your 

camera), DNG, and PSD (Photoshop Document, the format I use for 

my processed images). The top left capture on the facing page shows 

the overall structure I use to organize my images. I have used my PSD 

folder as an example, but all three folders (CR2, DNG, and PSD) contain 

the same subfolders. As the top right capture on page 190 helps illustrate, 

were I to put all of my bird images (ten to twenty thousand of them) 

into a single folder, it would be too large to be manageable. By breaking 

my Birds subfolder into additional subfolders, and so on as I have done 

with my Raptors subfolder (bottom capture, page 190), I am able to 

keep my subfolders from becoming excessively large. 

	 It is, in part, because of this structure that I name my images by 

species or location. If your first images include 100 birds, 50 dragonflies, 

and 25 scenics, I suggest that your initial subfolders should be Birds, 

Dragonflies, and Places. If your bird images include Mourning Doves, 

Northern Cardinals, Blue Jays, Turkey Vultures, and Red-tailed 

Hawks, I suggest you create 4 subfolders in Birds.
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Brown Bear, Anon Bear Observatory, Tongass NF, AK. Canon 1D Mark IV 
camera, Canon 500mm f/4.0 lens, ISO 640, f/8.0, 1/2000, EC -1 2/3.

Black-crested Titmouse, Santa Clara Ranch, Starr County, TX. Canon 7D camera, 
Canon 600mm f/4.0 lens, Canon 1.4x II teleconverter, ISO 500, f/9.0, 1/250.

	 Using the model shown in the top right screen capture on page 

190, these subfolders would be Doves, Finches, Jays, and Raptors. 

At this point there is no need to add subfolders to these subfolders 

as you do not have enough images to make any of them too large to 

be manageable. Likewise, there is no need to add Tanagers or Shrikes 

to your Jays subfolder as you do not have images of these subjects. 

	 Remember that you need to create three sets of these subfolders, 

(CR2, DNG, and PSD). Now move your dove images into Doves, 

your cardinal images into Finches, your jay images into Jays, 

and your vulture and hawk images into Raptors. 

	  There is no need, at this time, to add subfolders to your Dragonflies 

subfolders, so move all of your dragonfly images into them. This may 

change if you shoot a lot of dragonflies. (You may also wish to file 

any damselfly images you shoot with your dragonfly images until their 

combined number increases.) Let’s assume that you also have 

landscape images from New Jersey and New York. I suggest that you 

add two subfolders to your Places subfolders (New Jersey and New 

York). Now, separate your New Jersey images from your New York images, 

and move each group into its appropriate subfolder. Remember, you 

need to do this for each of your CR2, DNG, and PSD folders. 



193 194

Black-bellied Whistling-Duck. San Benito, Cameron County, TX. Canon 
EOS-3 camera, Canon 100-400mm f/4.5-5.6 lens @ 400mm. Provia 100 film.

STACKING YOUR IMAGES

Photoshop offers another way to make Bridge more efficient: 

Stacking (also called Grouping). Stacking allows you to highlight 

a number of images and, by clicking Stacks > Group as Stack or 

Ctrl/Cmd G, place them into a stack. These images will appear in 

the order that you had them in Bridge before you stacked them. 

For example, let’s consider the images you placed in your Raptors 

subfolder. You can highlight all your Turkey Vulture images and 

stack them as noted above. You can repeat this process for all of 

your Red-tailed Hawk images. The result will be two stacks in your 

Raptors subfolder. In the upper left corner of each stack will have 

a number telling you how many images are in it. You can open a stack 

by clicking on this number. You can unstack all or some of these 

images by highlighting those you wish to remove and then going 

into Stacks > Ungroup from Stack.

	 If you do not create many images of a given species or other 

designation, stacking may not be of interest to you. However, I 

have found it to be quite helpful. For example, I recently edited 

my Doves subfolder down to 84 processed images. Although this 

may not seem like a lot, it is more than can be fit on a single monitor 

viewed at a decent size. However, when I grouped these images by 

species, I had 11 stacks which nicely fit on my monitor with the 

images large enough to be easily seen well.
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Black Bear, Anon Bear Observatory, Tongass NF, AK. Canon 7D camera, 
Canon 70-200mm f/2.8 I lens, Canon 2.0x III teleconverter @ 265mm, 

ISO 2000, f/5.6, 1/200, EC -2/3.

				    RATING YOUR IMAGES

Photoshop provides you with two ways of rating, or otherwise 

ranking, your images: 1-5 stars and five colors. I use the former, 

but not the latter, although this is obviously a matter of personal 

choice. I also only rate my processed (PSD) images. 

	 There are two reasons I do not rate my RAW images (CR2s or 

DNGs). The first is that these are the ones I use when I name new 

images. Because I name my images with an increasing numerical suffix, 

I stack them in Bridge in numerical order, not star rated order. As noted 

on page 40, this allows me to open a stack, go to the last image in it, 

and copy the name of that image. I then highlight the new images of the 

same subject, go to Tools > Batch Rename, and paste the name I just 

copied in the text box. In order to not duplicate this name, I then cut 

and paste the suffix number on the next line and increase it by one.

	 The second reason I do not rate my RAW images is that I do not 

know how well I will like the final image until I have processed it. 

This means that I would have to process each image, rate it, and then 

relocate the corresponding RAW files and possibly edit the rating of 

each of them. This, to me, would just take too much time to make it 

worth the effort.

	 Before you begin rating your images, it is advisable to have an 

idea of what you want to accomplish with your rating system. My approach  

is based upon the following: Images that I think are good enough

that I am unlikely to delete them even if I later produce a significantly 

better image of the same subject, I rate at 5 stars. This can be done 

by enlarging the image (highlight it and press the space bar), which I 

usually do to more effectively view it, and then pressing the number 5 

key. For images that I view as strong but that I may someday edit out 

because of a better image, I rate at 4 stars. For images of subjects I do 

not have better images of or that show something unusual, I rate at 3. 

I rarely rate any image at 2, but I use 1 star occasionally for images 

I may use in my classes and seminars as examples of bad shots. 
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Halloween Pennant, South Cape May Meadows, Cape May County, NJ. 
Canon 1D Mark IV camera, Canon 100-400mm f/4.5-5.6 lens @ 400mm, 

ISO 500, f/13, 1/400, EC +1/3.

 	 Once I have rated all of the images in my Processed subfolder, 

I move them to the File subfolder. From there, they are moved to the 

appropriate PSD subfolders (or I create new subfolders as needed). 

	 If I have new images I wish to add to an already existing stack, I 

open that stack and move the images into it placing them where they 

should be based upon their ratings (5 stars first, 4 stars next, etc.).

	 If I do not have a stack for a group of new images, I place all 

of my 5 star shots to the front (left), followed by my 4 star shots, 

and, if any, by my 3 star shots of that subject. (I store my 1 stars in 

a separate folder.) I then stack this group by highlighting them and 

clicking Ctrl/Cmd G. If I want a particular image to be the top one 

in a stack, I open the stack, move that image to the front (left), and 

then close the stack. This can also be done by highlighting the image 

at issue and clicking Stacks > Promote to Top of Stack.

	 I should note that creating a new RAW stack, or adding images 

to an existing RAW stack, is a simpler process because these images 

are not rated. I always make certain that these images are in numerical 

order before I stack them. This is easy to do, given the way I name 

them, because all of my shots of the same subject have the same prefix 

followed by an increasing numerical suffix. Thus, by choosing Sort 

by Filename from the Options bar in Bridge, these images will be listed in 

numerical order. For a new stack, I simply highlight the images and click 

Ctrl/Cmd G. For an existing stack, I place the new images at the end 

of the stack, highlight the stack and the images, and click Ctrl/Cmd G.

STORING

At this point you should have three folders (CR2, DNG, and PSD)

with various subfolders in which all of your images have been 

placed. However, we have not addressed where these folders should 

be created, and this is critically important. 

	 I use five external hard drives as my final image destinations. 

This may seem like overkill, until you lose some of your images. For 

example, a few years back, I was working with an interior designer 

who had selected a group of my images to have printed for a new office 

building. When I wanted to download the high resolution versions of the 

images she had selected, my external hard drive would not function. I 

went to another hard drive and it, too, would not function. 
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Grasshopper Sparrow, Avon, Livingston County, NY. Canon 50D camera, Canon 
600mm f/4.0 lens, Canon 1.4x II teleconverter, ISO 800, f/8.0, 1/500, EC -1/3.

	 Fortunately, I had also backed up my images onto a series of 

high quality DVDs rated to last for 100 years. (I have since stopped 

using DVDs as backups because of the increase in size and reliability 

of external hard drives, and their reduced cost.)

	 The lesson to be learned is that you can not have too many backups 

for your images (unless, of course, you do not mind loosing 

your images forever!). Realistically, there has to be a limit to the 

number of hard drives anyone can have, but I strongly recommend 

multiple drives for each of your folders. 

	 The five drives I use include two 2 terabyte external hard drives 

and three 1 terabyte external hard drives. On one 2 terabyte drive, 

I have PSD and CR2 folders. On the other, I have PSD and DNG 

folders. On each of the 1 terabyte drives, I have a DNG folder. As a 

result, I have all of my PSD (processed) images on two external drives 

and all of my RAW images on five external hard drives.

	 One last point. I strongly urge you to keep at least one external 

hard drive containing all of your RAW and processed images off 

site. By this I mean that if you work at home, keep at least one 

such drive somewhere other than your home. For example, have a 

friend, especially if he or she is a photographer, keep a drive at his 

or her place (you can return the favor). Another option is to keep 

one drive in a safety deposit box. Just realize that you will periodically 

need to switch it out with another drive so you can keep all of your 

drives reasonably current.

	 The reason for this suggestion is that there is always the 

unfortunate possibility of a house fire or a robbery. Such an event 

would be bad enough by itself, but it would be even worse if it also 

meant that you lost your life’s work.

	 When you have stored all of your images, you can empty your 

New Images and Copies folders and subfolders.
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Gray-cheeked Thrush, South Padre Island, Cameron County, TX. Canon 
1D Mark II camera, Canon 600mm f/4.0 lens, ISO 800, f/4.0, 1/125.

Black-capped Chickadee, Brighton, Monroe County, NY. Canon 50D camera, 
Canon 500mm lens, Canon 1.4x II teleconverter, ISO 500, f/13, 1/320, EC -1/3.

SUMMARY AND CONCLUSION

There it is, a step-by-step basic workflow for downloading, editing, 

naming, processing, filing, and storing your digital images.

	 To summarize, before you download your images, create a New 

Images folder on your computer with four subfolders: Edited, File, 

New, and Process. Load your images into the New subfolder. Edit your 

images and then move them to your Edited subfolder. Next select 

a naming structure, batch name your images, and then move them 

into your Process subfolder. Now convert your camera’s original 

RAW images into DNGs and move the former into your File 

subfolder.

	 Next process your DNG images. Start by opening them in Adobe 

Camera Raw (ACR) and adjusting for color tint and exposure (if 

needed). Then open your images in Photoshop and apply our Lab 

action. Tweak your results as desired. For those images where it 

is warranted, apply one or both of our enhancement actions, sharpen 

your images as needed, and convert your images to 8 bits per channel.

	 Your final steps involve creating any folders and/or subfolders 

you need to store both of your RAW and processed images. Move 

these images into their appropriate folders and subfolders, stack 

them as desired, and make certain that you do this on multiple hard 

drives and that at least one of them is kept at another location.

	 Finally, let me know if this eGuide has been helpful, and more 

importantly, what would make it more helpful. I can be reached at 

www.mike-hannisian.com. Thanks, Mike.
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Guadalupe National Park, TX.  Canon 1D Mark II camera, Canon 28-70mm f/2.8 lens @ 65mm, ISO 200, f/4.5, 1/1600, EC -1/3.
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Black-bellied Whistling-Duck, Edinburg Wetlands, Hidalgo County, TX. Canon 1D Mark IV camera, Canon 300mm f/2.8 lens, ISO 500, f/5.6, 1/2500.
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White-tailed Hawk, Willacy County, TX. Canon 7D camera, Canon 600mm f/4.0 lens, Canon 1.4x II teleconverter, ISO 500, f/10, 1/500, EC +2/3.
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Green Heron, Santa Cruz Ranch, Starr 
County, TX. Canon 40D camera, 
Canon 500mm f/4.0 lens, Canon 
1.4x II teleconverter, ISO 200, f/6.3, 

1/800, EC -1/3.
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THE END


